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ABSTRACT 

Lipid membranes play a vital role in cell signaling processes. Membrane shape 

and lipid content affect interactions between cellular membranes and proteins. This 

research focuses on characterizing those interactions and their impact by using various 

biochemical and biophysical assays. These assays were applied to C-reactive protein 

(CRP), an immune system protein that interacts with lipid membranes and has at least 

two forms with different properties. Native, pentameric CRP (pCRP) is found in blood 

serum and is commonly used as a marker for inflammation. The modified form of CRP 

(mCRP) binds to the protein C1q, which activates the complement immune response. 

There is a gap in our knowledge of the biochemical information for the two forms of CRP 

and several different methods are used to make mCRP in the lab. In this work, we  

analyzed the pCRP to mCRP conversion using three biochemical denaturants: guanidine 

hydrochloride, urea with ethylenediaminetetraacetic acid (EDTA), and heating with 

dilute sodium dodecyl sulfate (SDS). After comparing results from biochemical assays to 

determine structural and functional differences, mCRP treated with dilute SDS and heat 

was the form that both significantly bound C1q and had an intrinsic tryptophan 

fluorescence level as anticipated for an intermediate form. 

After characterizing biochemical differences between functional mCRP and 

native pCRP forms, binding of pCRP and mCRP to curved membranes was analyzed 

with an in vitro membrane mimic assay that starts with a nanoscale pattern on a glass 
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coverslip to create curvature for a supported lipid bilayer to coat. By using fluorescent 

nanoparticles of a specific size, curvature based interactions can be visualized and 

quantified. Results show that the amount of CRP binding is not only dependent on 

protein conformation but also on membrane curvature size. 

Expanding the membrane curvature assay, used to visualize CRP membrane 

binding, to allow for cellular experiments was achieved by first melting the nanoparticles 

and then coating them with silicon dioxide, creating a permanent nanoparticle patterned 

substrate. Custom chambers were created and added to the nanoparticle patterned 

coverglass to reduce the required volume. Characterizations of the silicon dioxide coated 

surface were done with analysis of fluorescent lipids in supported lipid bilayers. The 

assays and results from this research not only contribute to better biochemical knowledge 

of CRP, but will be useful for future studies of proteins involved in cellular processes that 

have membrane interactions. 
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CHAPTER ONE: INTRODUCTION 

Molecular interactions on a cellular level are directly related to function. While 

some molecular interactions have been well studied and characterized, others still need 

extensive research. Of particular interest are interactions between immune system 

proteins and cells or bacteria that cause a clearance response. Improper clearance can be 

the cause of health problems, e.g. the buildup of atherosclerotic plaque leading to heart 

disease. Besides immune pathways, there are other pathways in the cell that are 

dependent on protein and membrane interactions. Examples include clathrin-dependent 

endocytosis, the SNARE protein complex interacting with synaptic vesicles, and the 

binding of microtubule associated proteins. Working to understand the steps of cellular 

pathways on a molecular level not only increases biochemical knowledge, but also brings 

medical insight that can lead to future treatments for diseases impacted by interaction 

problems. 

In this work, the binding interactions of C-reactive Protein (CRP), a member of 

the innate complement immune response, were characterized. CRP interacts both with 

lipid membranes and protein partners, and all these interactions depend on the 

conformational state of CRP. To assess these interactions, it was first necessary to 

determine a method for making a modified CRP conformational state in the lab. This 

CRP conformer was characterized and tested for biological relevance using a protein 

binding assay. To identify CRP-lipid interactions, the two CRP conformational states 
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were used in a membrane curvature binding assay with different curvature sizes and lipid 

compositions. Beyond the characterization of CRP interactions, the work herein describes 

advancements to the curved membrane binding assay, specifically the addition of custom 

made chambers reducing the volume and the use of silicon dioxide coated melted 

nanoparticles for permanency. These substrates can be used for both supported lipid 

bilayers and for cellular assays in future research projects. 

1.1 Lipids and Membranes  

Lipids play an important role in cellular and organelle membranes both 

functionally and structurally. Model membranes are commonly used to study lipid and 

membrane properties. Each lipid membrane assay used in the lab can be broken down 

into one of three formation categories: micelles, liposomes, and bilayers, the third 

category applies to the work presented here. An early assay for lipid studies is 

Langmuir’s film balance for measuring surface tension (1). Initial work with liposomes, 

originally referred to as phospholipid spherules, focused on how steroids, antibiotics, 

detergents, etc. would either stabilize or disrupt the liposome structures (2).  

While preliminary studies focused on characterizing lipid membranes, usually 

from methods that involved fractionating cells (3), current research utilizes bilayers and 

liposomes with both cellular and artificial membranes to study the interactions of those 

membranes. Advancements in cellular membrane isolation have allowed for most of the 

plasma membrane proteins and lipids to remain intact. One technique involves starting 

with cells that have been stuck to a glass surface and then disrupting them with a 

sonicator so that sheets of plasma membrane are left behind and other cellular 
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components are washed off (4). Since transmembrane proteins are still present, it is 

possible to use this model to do assays of complex membrane functions, such as 

endocytosis (4). 

Although the membrane sheet model is useful for assays that require 

transmembrane proteins and various lipids to be present, the complexity of the cell 

membrane can make it difficult to identify the exact lipid-protein interaction that is taking 

place. Simple lipid bilayers can be made using a technique referred to as supported lipid 

bilayers (SLB). The process starts with creating liposomes out of the lipid mixture and 

depositing them onto a surface, a process that depends on the conditions and charge of 

the vesicle (5). If specific sizes of liposomes are needed, lipids are extruded through 

polycarbonate membrane filters (6). Different conditions can cause the liposomes to split 

open and lay flat so they form a bilayer when attaching to the surface, to form a vesicular 

layer, or to fail to attach. Although the term attach is being used to describe the liposomes 

and SLB interacting with the surface, there is a small layer of water ranging from 0.5-1 

nm cushioning the lipids (7). Calcium ion concentration is important for negatively 

charged and zwitterionic liposomes to form SLBs (5). To introduce features into bilayers, 

SLBs can be formed on top of flat cover plates, lithographed textured surfaces, and plates 

that have areas with nanoparticles (either set on top or partially melted onto the surface) 

(8, 9). These options for studying flat and curved interactions, as well as the ability to 

vary the lipid mixture and proteins present, make SLBs a versatile tool for studying 

interactions between curved membranes, lipid composition, and/or proteins. 
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1.2 Protein-Lipid and Lipid-Membrane Interactions 

Interactions being studied between proteins and membranes with a SLB type of 

assay usually involve peripheral membrane proteins, which interact with the cell 

membrane surface either through specific headgroup binding or through insertion of the 

peripheral protein into the membrane (hydrophobic interactions). Binding of certain 

peripheral proteins to specific lipids can cause activation or inhibition of cellular 

processes (10). 

Besides SLB membrane assays, other assays used to study protein-lipid 

interactions include surface plasmon resonance, circular dichroism, electron 

paramagnetic resonance spectroscopy, and Fourier transform infrared spectroscopy (11). 

Fluorescence techniques can also be used for studying peripheral membrane protein 

interactions with lipids. Fluorescence recovery after photobleaching (FRAP) on lipid 

tethers from giant unilamellar vesicles has been used to study interactions of endophilin, 

an N-BAR domain protein involved in clathrin-mediated endocytosis, with curvature on a 

tubular membrane (12).  

The idea that BAR domains and other peripheral membrane proteins can sense 

regions of curvature suggests that there are specific regions where certain lipids and 

proteins are favored. Lipid and protein sorting can be attributed to lipid microdomains or 

membrane shape. Lipid rafts were originally envisioned as a way to explain the delivery 

of lipids selectively to the apical or basolateral surfaces of an epithelial cell (13). Lipid 

raft models are usually done on a larger scale to study their effect; however, in cells, lipid 

rafts are proposed to be less than 10 nm in diameter. Despite these differences, both in 
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vitro and in vivo models have benefitted from the idea of lipid rafts for studying lipid 

domains, which have high concentrations of cholesterol and sphingolipids. 

One proposed mechanism for lipid sorting into microdomains as well as areas of 

curvature is by the intrinsic shape of the molecule, based on the concept that molecules 

will favor locations where they minimize loss of energy due to spaces between lipids. A 

lipid may favor a particular curvature based on head or tail shape or size as seen in 

studies of simulated self-assembly of lipids with different head sizes (14). Despite these 

calculations, other research has not shown lipid sorting based on molecular shape (15). 

There is a proposed mechanism of proteins recognizing defects in the lipid membrane, 

which are found at regions of curvature, with the example of crescent-shaped BAR 

domains binding at curved membranes (16). 

1.3 C-Reactive Protein 

Besides BAR domains, there are many other proteins that bind to membranes as 

part of cellular processes. One such protein is C-reactive protein (CRP), an immune 

system protein involved in inflammation and clearance. CRP has been shown to bind to 

lipids on highly curved low density lipoprotein (LDL) mimics made from liposome 

coated gold nanoparticles (17). Binding of CRP to LDL in the body would likely activate 

the classical complement pathway, tagging LDL for clearance. 

1.3.1 CRP and the Classical Complement Immune Response 

Due to its role in the classical complement pathway and apoptosis, it is not 

surprising that CRP is found all over the body, despite being produced mainly in 

hepatocyte cells. Normal levels of CRP are considered to be around 0.8 mg/L, however, 
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during inflammation CRP levels can increase rapidly and reach 1000 fold in 48 hours 

(18). When bacteria or apoptotic cells are present, the circulating CRP binds to their cell 

membranes. CRP has established interactions with phosphocholine, which is found on a 

number of bacterial and eukaryotic membranes (19). CRP is known to bind to apoptotic 

cells in the presence of Ca2+, and C1q, a protein with a collagen-like stem and six head 

groups (20), is required for clearance of those cells (21). When C1q binds to CRP, the 

classic complement pathway (Figure 1) is activated, ending with the membrane attack 

complex creating pores in the membrane allowing the flow of fluid and ions and the cell 

to lyse (19, 20). 
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Figure 1. Diagram overview of the classical complement pathway with CRP activation. CRP first 

binds to the membrane and then recruits C1q. Once the rest of the C1complex binds, the classical 

complement pathway is activated, ending with cell lysis from the membrane attack complex (20). 

Factor H inhibits the classical complement pathway and leads to the alternative pathway, ending 

in phagocytosis. 

Beyond this role with C1q in the classical complement pathway, CRP has been 

found to promote phagocytosis (functioning as an opsonin) through recruitment of Factor 

H, which is a regulator of the complement system (22). CRP gene expression is regulated 

Bacterial or apoptotic cell 
membrane

mCRP binds to the 
membrane

C1q binds to mCRP

C1r and C1s complete the 
C1qr2s2 complex

Classical complement 
pathway is activated

Subsequent complement 
protein binding and 
convertase activity forms 
the membrane attack 
complex

Factor H inhibition leading 
to phagocytosis
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by interleukin-6 (IL-6), which controls the expression of many acute phase proteins. CRP 

has pro-inflammatory and anti-inflammatory features, which are predicted to be from the 

pentameric (pCRP) and modified (mCRP) conformers, respectively (23, 24). With the 

multiple features of CRP, it is no surprise that in addition to being produced in hepatocyte 

cells, CRP synthesis has been discovered in atherosclerotic plaques, lymphocytes, 

monocytes, and neurons.  

1.3.2 CRP and Cardiovascular Disease 

Of all the areas of the body where CRP is found, the location of atherosclerotic 

plaque is of particular interest due to a link between high CRP levels and cardiovascular 

disease (CVD) risk (19, 25, 26). Elevated CRP levels can be caused by acute infection or 

a chronic illness. If the inflammation decreases with time or treatment, the CRP levels 

should return to a normal range. Inflammation of the endothelium can cause 

atherosclerosis due to the expression of adhesion molecules (27), indicating that some 

types of inflammation can trigger plaque formation. Furthermore, some treatments for 

CVD, such as statins to lower cholesterol, have been shown to decrease inflammatory 

markers such as CRP. 

Inflammation is a major part of atherosclerosis, regulating the protective fibrous 

cap and the plaque thrombogenicity (27–29). Atherosclerotic plaque contains the mCRP 

conformer, as measured by antibodies that bind specifically to the modified form. In 

contrast, healthy vessels have neither form of CRP, and pCRP is found in serum (23). 

Research suggests that conversion of pCRP to mCRP is localized to inflamed endothelia, 

and plays a vital role in atherogenesis (30). A necessary process of clearing LDL from 
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plaques involves the transformation of macrophages into foam cells. CRP has been found 

to assist macrophages in taking up native LDL and becoming foam cells (31). Initially a 

rise in CRP levels should help clear atherosclerotic plaques. However, if the recruitment 

of Factor H by CRP is high, then C3 convertase formation will be blocked, which 

prevents the membrane attack complex from being formed as well as opsonins (20). This 

prevention may leave cells in a necrotic or semi-apoptotic state without phagocytosis to 

completely clear out debris.  

CRP is known to bind to apoptotic cell membranes (19, 23, 32) and the contents 

of the core of atherosclerotic plaque include uncleared apoptotic cells as well as mCRP 

(23, 33). Characteristics of apoptotic cells that could induce binding include membrane 

shape and lipid composition (blebbing, phosphatidylserine or oxidized lipids being 

present) (34, 35). Apoptotic cells have been shown to convert pCRP to mCRP (23). 

However, it is unclear if mCRP takes the form of a monomer, loose pentamer, or 

oligomer (36, 37). Research in this field has been hampered due to the absence of 

information regarding what triggers conversion in biological systems. The results from 

the experiments outlined below contribute to a better knowledge of the pCRP and mCRP 

conformational states and their interactions with curved membranes. 

As mentioned above, CRP has been shown to bind highly curved LDL mimics 

(38), and LDL may play a role in atherosclerosis and CRP conversion (39). In these 

studies, pCRP binds preferentially on LDL mimics with a diameter less than 28nm, 

converts to mCRP, and can bind C1q (40). CRP recognizes membrane curvature, and 
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membrane shape is able to cause conformational changes in the absence of lipid 

oxidation or other proteins (38). 

Current literature is unclear on the precise interactions of mCRP and pCRP at 

sites of inflammation with other inflammatory components. The research performed here 

includes an in vitro assessment of specific interactions of conformers with membrane 

curvature and lipid composition. A strength of the membrane curvature assay is the 

unique ability to isolate components involved in apoptotic membranes and analyze the 

binding of CRP in the isolated system. Once individual components are studied, it is 

useful to return to a cellular membrane approach, which can be accomplished with the 

expansions to the membrane curvature assay. 
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CHAPTER TWO: COMPARISON OF BIOCHEMICALLY PREPARED 

MODIFIED C-REACTIVE PROTEIN 

2.1 Introduction 

C-reactive protein (CRP) is a mediator of inflammation and plays an active role in 

the complement immune response to clear foreign material and apoptotic cells from the 

body (19). The amount of CRP in serum is related to numerous disease states, such as 

coronary heart disease (41), Alzheimer’s disease (42) and autoimmunity (43, 44). In 

many diseases, elevated CRP levels are related to increased risk (i.e. coronary heart 

disease, Alzheimer’s disease) and CRP is often measured as a marker for chronic disease. 

In other diseases (i.e. arthritis, multiple sclerosis) overexpression of CRP in mouse 

models has been shown to be protective (45, 46). Although elevated CRP levels reveal 

inflammation, the activity of CRP is necessary for immune system regulation.  
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Figure 2. pCRP has rotated protomers and PC binding sites, as seen by the secondary structure. 

Secondary structure of pCRP includes α-helices (orange) and β-sheets (purple) along with 

calcium (yellow) dependent PC (blue) to PC binding site (47, 48). Distance from center of PC 

binding between protomers is 4.2 nm. 

Native, pentameric CRP (pCRP) is a stable, soluble, homopentamer present in 

serum. CRP binds to damaged cell membranes and foreign pathogens to activate an 

immune response for clearance (19, 49, 50). It has been proposed that cellular damage 

exposes phosphatidylcholine (PC) headgroups and this allows CRP to bind (19) through 

Ca2+ dependent binding sites present on each monomer (48) shown in Figure 2. Upon 

binding membranes, CRP activation of the complement immune response likely involves 

pentamer dissociation to reveal neoepitopes (23, 36). The new form of CRP is referred to 
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as modified CRP (mCRP), but the precise structure of this conformation is not known. In 

response to the new portions of CRP that are exposed, binding partners, such as C1q, 

recognize CRP and the complement immune response is initiated (51). The majority of 

recent research points to membrane bound CRP binding the globular head region of C1q 

(32, 50, 52, 53). However, mCRP has been shown to bind both the globular head and 

collagen-like region, with higher binding for the collagen-like region (50). To activate 

C1q, it is predicted that multivalent binding needs to occur through the globular heads 

(54). In the pentameric state the pCRP presents only one binding site for the large C1q, so 

multiple copies are needed (53). One pentamer that dissociates into membrane bound 

mCRP could lead to multivalent C1q binding. In support of this, other studies have 

shown that the native form of CRP is incapable of binding C1q and a modified form is 

required (32, 55). 

 

Figure 3. Binding sites of CRP ligands. Two orientations of pCRP and mCRP showing PC bound 

near the top of the monomer. The cholesterol binding sequence (56) is highlighted in magenta in 

both structures and the amino acids residues thought to bind C1q are highlighted in yellow on the 

monomer (53). Imaging utilized UCSF Chimera software with the 1B09 CRP protein data bank 

file (47, 48). 
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The conformation of CRP affects biochemical reactivity and likely has different 

physiological effects (57). In most patient studies, the soluble, pentameric form of CRP is 

measured, but there is clear evidence that the conformational state of CRP affects 

function (32, 37, 58, 59). Multiple forms of CRP have been measured in patient samples, 

where atypical forms of CRP were identified in patient serum by gel electrophoresis and 

correlated to obesity (60). Modified forms, as recognized by antibodies that are specific 

for epitopes that are not exposed in pCRP, have also been found in plaque (23), 

suggesting an active role of modified CRP in cardiovascular disease. 

The causes and effects of CRP conformational changes are not well understood. 

Proposed causes of conformational change include membrane binding to specific lipids 

and/or the presence of an acidic environment, like those at sites of inflammation (61, 62). 

Membrane shape may also play a role in CRP conformational change since certain forms 

of CRP have curvature preferences (38, 63). In general, binding to membranes likely 

stabilizes the transition from a pentamer to monomer by allowing for insertion into 

membranes to stabilize hydrophobic portions of the protein, like the cholesterol binding  

domain (64), that are newly exposed in the transition from p to m. 

The main purpose of this work was to design a method for CRP conversion in the 

laboratory and an assay for creating a form of CRP that mimics mCRP activity. Since one 

physiological purpose of CRP is to activate C1q, we have chosen our readout for making 

an active, modified form of CRP as one that can bind C1q. To determine the best method 

for CRP conversion, we built upon the work of others where mCRP was made 

biochemically with 8 M urea and 10 mM EDTA  (32, 58, 64–66), with Guanidine HCl 
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(67) or by dilute SDS and heat (40, 59). We compared a variety of methods for 

synthesizing mCRP from serum purified pCRP and then tested each method for the 

ability to produce a form of CRP that: 1) runs differently than pCRP on a non-denaturing 

polyacrylamide gel and 2) binds C1q, one downstream binding partner of CRP in the 

complement immune response. The change in conformation was also assessed by 

tryptophan (Trp) and 1-anilinonaphthalene-8-sulfonic acid (ANS) fluorescence, which 

show clear differences in conversion methods for mCRP. These methods build upon the 

work of others that have characterized CRP states by non-denaturing PAGE methods (59) 

and adds functional relevance through ELISA based assays with C1q. We conclude that 

dilute SDS/heat treated pCRP consistently produces a functional form of mCRP, whereas 

only certain concentrations of GndHCl and urea/EDTA have the possibility of being 

functional mCRP. 

2.2 Method 

Experimental Contributions 

The ANS fluorescence assays were performed by Dr. Aml Alnaas and the circular 

dichroism of CRP was done by Yuheng Cai. The remaining experiments were done by 

Carrie Moon. 

Materials 

C-reactive protein was purchased from Academy Bio-Medical Company (#30P-

CRP110) and stored at 4 °C for up to 6 months. Standard CRP concentration used was 

57.5 μg/mL unless otherwise noted. C1q was purchased from Complement Technologies 

(#A099). Standard buffers used for the majority of these experiments were 30 mM 
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HEPES or PIPES (J.T. Baker), 2 mM calcium chloride, 140 mM sodium chloride, pH 

6.4. Chemicals were purchased from Thermo Fisher Scientific or Sigma Aldrich unless 

otherwise noted. Stock denaturant solutions of 6 M GndHCl and 8 M urea, 10 mM 

ethylenediaminetetraacetic acid (EDTA) were made in standard buffer (pH 6.4). GndHCl 

and urea CRP conversion samples were allowed to incubate for 2 hours at room 

temperature prior to analysis. Dilute sodium dodecyl sulfate (SDS) treated mCRP was 

made by combining CRP in standard buffer with 0.01% SDS and heating for 1 hour at 80 

°C (40). All error values are standard error of the mean. 

Structural Analysis 

The published crystal structure of CRP with bound PC was used for all structural 

illustrations and analysis (48). Renderings were done using the UCSF Chimera software 

(47). 

Non-denaturing PAGE 

CRP forms were visualized using a non-denaturing polyacrylamide gel 

electrophoresis (PAGE) assay previously established (40) Standard Laemmli conditions 

were followed (68) with the exception of using 0.005% SDS in the gel and using native 

sample buffer (no SDS, β-mercaptoethanol, or heat). These modifications ensured a non-

denaturing gel. Standard tris-glycine running buffer containing 0.1% SDS was used. The 

amount of CRP loaded into each well was 0.43 μg. Gels were run at 80 V for 2 hours and 

then silver stained. Relative molecular weights for denatured proteins were marked for 

comparison by using Precision Plus Dual Color Standards (Bio-Rad #1610374). Gels 

shown are representative of at least 4 experiments. 
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Tryptophan Fluorescence Spectroscopy 

All fluorescence measurements were measured in a Tecan Infinity M1000 Plate 

Reader using black polystyrol half area 96 well plates (Corning #3694). The intrinsic 

fluorescence of CRP was measured using 57.5 µg/mL of CRP, which was compared with 

3.06 µg/mL tryptophan (the equivalent concentration for the amount of CRP used based 

on 6 tryptophan residues per monomer). Excitation wavelength was 280 nm with a 

bandwidth of 2.5 nm. Emission spectra were collected from 300-400 nm with a step size 

of 5 nm and a bandwidth of 5 nm (Figure 4). The fluorescence intensity from 300-400 nm 

was integrated and then each value was normalized to the integrated pCRP intensity. Data 

points were not included when they fell more than two standard deviations from the mean 

value. The GndHCl denaturation curve was fit to the following equation (69):  

F =
(𝐹𝑁 +𝑚𝑁[𝐷]) + (𝐹𝑈 +𝑚𝑈[𝐷]) ∗ 𝑒

−(
∆𝐺°𝑁/𝑈+𝑚𝐺[𝐷]

𝑅𝑇
)

1 + 𝑒
−(

∆𝐺°𝑁/𝑈+𝑚𝐺[𝐷]

𝑅𝑇
)

 

Where F is measured fluorescence, FN, and FU are the fluorescence of the native 

state, and the unfolded state, respectively. The slopes are for the native (mN) and unfolded 

(mU) states of the protein. [D] is the concentration of denaturant. ΔG°N/U is the Gibbs free 

energy of unfolding. R is the universal gas constant (8.314 J mol-1 K-1) and the 

temperature (T) used for calculations was 298 K. 
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Figure 4. Sample fluorescence spectra from pCRP and mCRP made with SDS and heat. Data 

from each spectrum was integrated from 300 to 400 nm to give a single value for each well, those 

values were normalized to the pCRP value for that day. Combined data is plotted with averages 

and SEM in Figure 5 and Figure 7. 

Dynamic Light Scattering 

Dynamic light scattering (DLS) was performed on a DynaPro Plate Reader II with 

Dynamics version 7 software (Wyatt Technology) using a 384 well glass bottom plate 

(Greiner Bio-One Sensoplate #781892). CRP (500 µg/mL in pH 6.4 PIPES buffer, details 

above) was placed into 4 wells for measurements (50 µL). The plate was centrifuged at 

200 rpm for 2 min. Readings were performed at 25 °C using a 5 s acquisition time with 

auto-attenuation. The solvent setting for the system used was based on phosphate 

buffered saline with a refractive index of 1.333 (at 589 nm for 20 °C) and a viscosity of 

1.019 cP. Each well had 10 acquisitions. A Rayleigh spheres model was used to fit the 

data with the Dynamics software. 

Circular Dichroism 

CRP samples of pCRP and mCRPHeat were prepared for circular dichroism (CD) 

by dilution in standard HEPES buffer at pH 7.4 to a concentration of 19.6 µg/mL. Dilute 
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SDS samples contained 19.6 µg/mL of CRP in phosphate buffer (10 mM disodium 

phosphate, 2.7 mM potassium chloride, 1.8 mM monopotassium phosphate, 1 mM 

calcium chloride, pH 7.6) with 0.005% SDS. CD spectra from 207-250 nm was recorded 

using a JASCO J-1500 Circular Dichroism Spectrometer. Samples with SDS were heated 

and measured at 5-degree intervals from 20 to 80 °C and then allowed to cool to room 

temperature (20 °C) before the final scan. Background CD spectra from buffers was 

subtracted for all samples. 

ANS Fluorescence Assay 

1-Anilinonaphthalene-8-sulfonic acid (ANS), a hydrophobic fluorescent probe 

purchased from Cayman Chemical (Ann Arbor, MI), was used to monitor the 

conformational changes of CRP after treating the protein with different denaturants. The 

stock solution of 100 mM ANS was dissolved in DMSO and diluted to a final 

concentration of 190 μM with Millipore water. CRP (50 μg/mL) was incubated with the 

GndHCl or urea/EDTA denaturants in HEPES buffer (pH 6.4) for 2 hours at 37 °C. 

Dilute SDS CRP samples were heated for 1 hour at 80 °C with 0.01% SDS in HEPES 

buffer (pH 6.4). The control pCRP sample was diluted in TBS buffer (50 mM Tris-HCl, 

150 mM NaCl, 0.1 mM CaCl2, pH 7.2). Fluorescence intensity of ANS was measured 

using an excitation wavelength of 390 nm, and emission spectra were measured from 440 

nm to 650 nm. The same plate reader and plates listed above in tryptophan fluorescence 

were used for ANS experiments. 
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Enzyme Linked Immunosorbent Assay (ELISA) 

The binding of CRP to C1q was measured by performing an ELISA with C1q as a 

capture at a concentration of 1 µg/mL, following previously published procedures (40). 

Bovine serum albumin (BSA, 1 µg/mL) was used as a control in place of the C1q 

capture. BSA or C1q were diluted in coating buffer (30 mM sodium carbonate, 70 mM 

sodium bicarbonate, pH 9.6, Sigma Aldrich). 100 µL of coating solution was added to the 

microwells in a Microlon 600 96W high binding clear microplate (either Greiner 

Bioscience 655081 or Nunc Maxisorp Immuno Plate 446612). Control wells were tested 

with plain coating buffer (no protein) which resulted in similar results as with BSA due to 

the BSA block. Fish gelatin at 3% was tested as an alternative blocking agent, however 

since this failed to block non-specific binding, BSA or fatty acid free BSA was used as a 

blocking agent. After a 2 hour incubation at 37 °C or an overnight incubation at 4 °C, 

wells were washed three times with 300 µL of phosphate buffered saline with 0.05% 

Tween-20 (PBST; Acros Organics) and once with 300 µL of phosphate buffered saline 

(PBS). Next, 300 µL of blocking buffer (3% w/v BSA in PBST) was added and the plate 

was incubated at room temperature for 2 hours. In between each step in the assay, wells 

were washed as described above (three times with PBST and once with PBS). 100 µL of 

CRP (1.8 µg/mL) in diluting buffer (1% w/v BSA in PBS) was added and incubated for 1 

hour at 37 °C. The antibody, a biotinylated polyclonal anti-CRP (Academy Biomedical 

Co. #CRP30BG1), was diluted at a ratio of 1:5,000 in diluting buffer and 100 µL was 

added and incubated for 1 hour at 37 °C. After washing, 100 µL of a 1:10,000 dilution of 

HRP-Strep was added to each well and incubated for 30 minutes at 37 °C. A final wash 
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sequence was followed by the addition of 100 µL of 3,3’,5,5’-tetramethylbenzidine 

(TMB) substrate. After the color was allowed to develop (5-10 min) at room temperature, 

the reaction was stopped by the addition of 100 µL of 0.5 M sulfuric acid, turning the 

reaction solution from blue to yellow. Absorbance was measured at 450 nm, with a 

reference absorbance of 620 nm on a Microplate reader (Tecan infinite-M1000 PRO). 

Data was normalized by day to either 0 M denaturant (pCRP) or mCRP with SDS and 

heat absorbance values. 

2.3 Results 

To determine the stability of the native, pentameric form of CRP, we denatured 

CRP using two common denaturants, urea/EDTA and GndHCl. The intrinsic tryptophan 

fluorescence was measured and found to decrease with increasing denaturant, as 

expected, for most concentrations (Figure 5A and Figure 5B). The change in fluorescence 

occurs as some of the 6 Trp residues (per monomer of CRP) go from a hydrophobic 

protein environment to a more aqueous environment. Denaturation with GndHCl led to a 

clear transition (Figure 5A) between 2 and 2.75 M GndHCl, however, the gradual decline 

in fluorescence from 0 to 2 M suggests conformational changes are occurring even at low 

concentration. Interestingly, tryptophan fluorescence increases at GndHCl concentrations 

higher than 4.25 M (see Figure 6A), so only data ≤ 4.25 M GndHCl was used for fitting. 

A slight change in the appearance of the band with non-denaturing gel is observed at 

higher concentrations of GndHCl (Figure 6B). The change in fluorescence was fit, as 

described in the methods, to give a Gibbs free energy of unfolding (ΔG°N/U) of 32 ±12 

kJ/mol and a m value of -13 ±5 kJ/mol. With a weaker denaturant, urea/EDTA, the 
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decrease in fluorescence is more gradual and lacks a clear transition. If pCRP was 

completely denatured, the expected Trp fluorescence would be equal to the same amount 

of free Trp in buffer. The integrated fluorescence intensity for free tryptophan based on 

the concentration of CRP present was measured in the denaturants for comparison with 

CRP samples, as shown in Figure 5A, Figure 5B, and Figure 7C. It is interesting to note 

that the tryptophan fluorescence of CRP treated with 4 M GndHCl falls below that of free 

tryptophan, while 7 M urea treated CRP and free Trp have similar integrated fluorescence 

intensities.  
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Figure 5. Intrinsic fluorescence and non-denaturing PAGE assays of CRP treated with GndHCl 

and urea. Intrinsic, tryptophan fluorescence was measured by exciting solutions at 280 nm and 

recording fluorescence from 300-400 nm for both GndHCl (N=8, A) and urea/EDTA (N=10, B) 

treated CRP (black filled circles) as well as select concentrations for free tryptophan (open 

circles). The integrated fluorescence was normalized to the 0 M denaturant data point. The solid 

line in A is a fit used to determine the energy of unfolding as described in the Experimental 

Procedures. Error bars are ± SEM. Non-denaturing PAGE of CRP treated with GndHCl (C) and 

urea/EDTA (D) after two hours of incubation. The ladders shown are SDS-PAGE (denatured) 

protein standards for relative molecular weight comparison. Gels shown are representative of at 

least 4 experiments. 

After measuring the intrinsic fluorescence to identify changes in the exposure of 

Trp residues to an aqueous environment, samples were loaded onto a non-denaturing 

polyacrylamide gel to assess the presence of different states of CRP. Non-denaturing gel 

conditions were used because mCRP fails to appear under native gel conditions that 

contained no SDS, which has been confirmed by others (59). Both the molecular mass 

and the charge affect migration in this assay. In Figure 5C and D, a clear transition occurs 
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where a modified form of CRP begins to show, running similar to the 20 kDa standard. 

Although the gels shown in Figure 5 appear to have slightly different running distances 

for the mCRP band, comparisons of all gels run do not show a consistent difference. With 

GndHCl treatment, this band first shows up at 1.75 M GndHCl and is fully present at 

2.75 M, matching the profile of intrinsic fluorescence in Figure 5A. When pCRP is 

treated with urea/EDTA, a clear transition exists in the gel from 2.25 to 4.00 M urea. The 

mCRP band increases over this range and the pCRP (not shown but retained in the 

stacking portion of the gel) disappears. pCRP is a 115 kDa pentamer with a pI of 6.4 that 

changes to 5.6 upon monomerization with urea (67). The pentameric form has less charge 

density, is larger, and therefore does not run well into the gel. A haze of protein is also 

observed in the gel and this fully disappears at 4.00 M. This could be due to alternative 

states of pCRP that have not been fully characterized and these are present in the absence 

of urea (Figure 5D, 0.00 M). 

 

Figure 6. Higher concentrations of GndHCl lead to changes in intrinsic tryptophan fluorescence 

and non-denaturing gel bands. A) The integrated, normalized tryptophan fluorescence of GndHCl 

treated CRP (black filled circles), N=8. Free tryptophan was measured for pCRP (0 M GndHCl) 

and 4 M GndHCl treated CRP (open circles), N=9. All error is SEM. B) Non-denaturing PAGE 

of higher GndHCl concentrations with shift in bands of mCRP at higher concentrations. Gel is 

representative of 4 gels.  
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To determine if other denaturants can be used to make a functional form of 

mCRP, dilute amounts of detergent (SDS) were tested along with heat. Non-denaturing 

PAGE reveals a band around 20 kDa for mCRP made from exposure to 0.01% SDS with 

heat and a high band for pCRP (Figure 7A). Since pCRP remains in and near the stacking 

portion of the non-denaturing PAGE gel, dynamic light scattering (DLS) was used to 

confirm that pCRP is not aggregating. 99.85% ± 0.09 of the results for the hydrodynamic 

radius fell between 0 and 10 nm, with an average radius from that range is 4.12 ± 0.15 

nm (Figure 7B). DLS with SDS and heat treated mCRP gave results that indicated 

aggregation due to the high concentration (500 µg/mL) needed to run the experiment. 

The different properties of dilute SDS and heat treated CRP are evident when free 

tryptophan and CRP levels of all the denaturants are compared. Only mCRP made with 

SDS and heat has a normalized integrated fluorescence between the pCRP and free 

tryptophan levels (Figure 7C). 
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Figure 7. Dilute SDS with heat treatment leads to monomeric CRP. A) Non-denaturing PAGE of 

pCRP and CRP heated with 0.01% SDS (mCRP) demonstrates that the two forms have different 

electrostatic properties. B) Data on the graph is from the 0-10 nm radius range and represents 

99.85% ± 0.09 mass detected by dynamic light scattering. Average radius measured is 4.12 ± 

0.15 nm. C) Comparison of intrinsic tryptophan fluorescence for pCRP and SDS with heat mCRP 

with fluorescence of free tryptophan. Normalized to pCRP, N=9. All error is SEM. 

 
Figure 8. Additional non-denaturing PAGE of SDS treatment concentrations and times. 

 



 

 27 

Circular dichroism (CD) was used to measure CRP during the denaturation 

process to assess whether conformational changes were occurring to the secondary 

structure. pCRP and mCRP have a different CD signal from 210 to 230 nm with a dip for 

pCRP (Figure 9A). Although there is a different CD signal for pCRP and mCRP forms, 

the two methods tested for mCRP – with dilute SDS and heat or with just heat – have 

similar spectra. CRP treated with dilute SDS was tested at various temperatures and 

Figure 9B shows full conversion from pCRP to mCRP around 70 °C with a less 

structured spectra. CRP that has been cooled back to room temperature post heating to 80 

°C continues to show less structure in the 210-230 nm region of α-helices and β-sheets. 
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Figure 9. Circular Dichroism of CRP forms shows a structural change. A) Circular dichroism 

spectra of pCRP (red line) and mCRP made from heat only (grey line) and dilute SDS with heat 

(red line). B) CRP sample with dilute SDS in buffer heated in the cuvette from 20-80 °C with CD 

spectra recorded and final sample allowed to cool back to room temperature. 

To monitor CRP unfolding after incubation with different denaturants ANS, a 

hydrophobic fluorescent probe, was utilized. ANS is frequently used in biochemistry and 

biophysics research to identify protein folding and aggregation. ANS binds to 

hydrophobic regions of proteins, which leads to a significant increase in its quantum yield 

and a blue shift in the emission maxima (70). Previous research has used ANS to 

investigate the conformational changes of CRP at various pH and temperatures (62, 71). 

Because ANS binds hydrophobic regions, an increase in ANS fluorescence indicates that 
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the protein has more hydrophobic regions exposed. As shown in Figure 10, treatment 

with 3 M GndHCl (Figure 10A), 6 M urea (Figure 10B), or 0.01% SDS with heat (Figure 

10C) caused hydrophobic portions of CRP to be exposed. SDS-treated CRP showed the 

largest change (Figure 10C, black circles) from the untreated CRP (grey triangles in all 

figures) compared to other denaturants.  

 

Figure 10. Treatment of CRP with denaturants increases ANS binding. ANS fluorescence upon 

binding to CRP incubated with (A) 3 M GndHCl for 2 hours at 37 °C (black circles), (B) 6 M 

urea/EDTA at 37 °C for 2 hours (black circles), and (C) 0.01% SDS with incubation at 80 °C for 

one hour (black circles). Grey triangles for all are pCRP. N=3 

After altering the conformation of pCRP with urea/EDTA, GndHCl and 0.01% 

SDS with heat, we assessed whether the new forms of CRP could bind C1q, a well-

established binding partner for initiation of the complement immune response. Enzyme-

linked immunosorbent assays (ELISAs) were performed where C1q was used to capture 

CRP. A polyclonal antibody to CRP with a biotin linkage was used to then bind 

horseradish peroxidase linked streptavidin (HRP-Strep). In Figure 11, the GndHCl treated 

CRP clearly shows binding to C1q (black filled circles), however, for most 

concentrations, similar binding was observed for a control, where bovine serum albumin 

(BSA) was used as the capture protein. Statistical significance between BSA and C1q 

binding only exists at 1.5 M GndHCl (p-value of 0.0037 for Student’s paired t-test). Urea 

treated CRP binds BSA comparably to C1q and the binding is not statistically significant 
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(Figure 6B). Acid treated CRP shows similar behavior which indicates that the binding 

observed is not specific (62). However, dilute SDS with heat-treated CRP does have 

significant C1q binding with a p-value of 0.0103 as determined by a two-tailed paired 

Student’s t-test (Figure 11). Table 1 contains a detailed list of all p-values. As pCRP 

converts to mCRP, more amino acid residues are exposed, as well as areas of binding 

sites for ligands (Figure 13 and Figure 3). A summary of the results for each CRP form is 

shown in Table 2. 



 

 31 

 

Figure 11. Denaturation of pCRP by GndHCl, urea/EDTA, or dilute SDS with heat alters CRP 

binding to BSA and C1q. ELISA with BSA (open circles or solid bars) or C1q (filled circles or 

striped bars) as the capture agent was performed to determine if denaturation at a certain 

concentration leads to a form of CRP that can bind C1q. A) CRP treated with 1.5 M GndHCl (or 

higher concentrations) leads to C1q binding, however the binding above 2 M GndHCl is not 

specific; BSA capture works equally well. B) Urea treated CRP binds C1q at 5 M and higher 

concentrations, but also binds BSA non-specifically. Data for A and B was normalized to pCRP 
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(0 M GndHCl or urea). C) C1q captures CRP treated with 0.01% SDS and heated at 80 °C for 1 

hour (solid black), but not pCRP (solid grey) or antibodies (solid light grey). BSA captures 

mCRP significantly less than C1q (black stripes), but captures more 0.01% SDS with heat treated 

CRP than pCRP (grey stripes) or antibodies (light grey stripes). Data was normalized to the 

average mCRP absorbance with C1q capture. Significance was calculated using a two-tailed 

Student’s paired t-test (p-values < 0.05 shown as * and < 0.01 shown as **). Detailed 

significance for C can be found in supplemental Table 1. Error bars are SEM and only shown in 

the positive direction for clarity. Often the SEM is smaller than the data point. 

Table 1. ELISA t-test results. 

t-test partner Capture Antigen Values 

(paired, two-

tailed) 

Significance 

C1q-mCRPSDS BSA mCRP 0.0103 * 

BSA pCRP 0.0067 ** 

BSA None 0.0102 * 

C1q pCRP 0.0091 ** 

C1q None 0.0106 * 

C1q-pCRP BSA mCRP 0.5775 NS 

BSA pCRP 0.0014 ** 

BSA None 0.0035 ** 

C1q None 0.6587 NS 

BSA-mCRPSDS BSA pCRP 0.0432 * 

BSA None 0.0629 NS 

BSA-pCRP BSA None 0.2092 NS 

C1q-None C1q BSA 0.0106 * 

C1q- 

CRP1.5M GndHCl 

BSA CRP1.5M GndHCl 0.0037 * 

C1q- 

CRP7M Urea 

BSA CRP7M Urea 0.2972 NS 

 

2.4 Discussion 

CRP is known to have both a pentameric native form and a modified form that 

exposes neoepitopes (55, 67). We confirmed with DLS that purchased pCRP, prior to 

denaturation methods, had a hydrodynamic radius (RH) within range for the pentameric 

state (4.12 ± 0.15 nm, Figure 7B). In comparison, the measured radius from the pCRP 

crystal structure is 5.1 nm (22) and the radius of gyration (Rg) for pCRP is 3.7 nm, as 

determined by x-ray scattering (66). The Rg has a linear relationship to the RH for 
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spheroidal objects that can be summarized by the equation Rg = 0.775 x RH (72). Using 

the RH found by DLS above, our calculated radius of gyration would be 3.19 ± 0.12 nm. 

Since CRP is a disk-shaped pentagon (73) and not a perfect sphere, a slight discrepancy 

between the calculated and observed Rg values is expected. With salt concentrations in 

buffer, CRP is expected to stay as a pentamer and not form a decamer (66). Having 

established that CRP without any denaturant is the native, pentameric form, the next step 

was to produce an in vitro mCRP.  

Denaturants, such as chemicals or heat, have a wide range of effects on proteins 

and in vitro studies of denaturing individual proteins provide a better understanding of 

protein function and structure (74–77). Chemicals used to denature include strong acids 

and bases, salts, detergents, or organic solvents; examples include sodium dodecyl 

sulfate, guanidine hydrochloride, urea, hexane, and trifluoroacetic acid (74, 78). These 

chemical denaturants disrupt the interactions that stabilize the secondary, tertiary, and/or 

quaternary structures of the protein (i.e. van der Waal’s interactions, salt bridges, and 

hydrogen bonds) and alter the native state. As larger concentrations of denaturants are 

added, the protein can have meta-stable forms, as previously established in work with 

oligomeric proteins (79). One way of measuring denaturation and stable states is to use 

tryptophan fluorescence. Depending on the location of the tryptophan residues, unfolding 

will cause either quenching or increased fluorescence intensity and a melting curve for a 

protein can be used to calculate data about stability. Results here from many biochemical 

assays indicate that methods used to make mCRP have varied effects on the structure of 

pCRP. 
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Figure 12. Chemical denaturants guanidine hydrochloride, urea, and SDS were incubated with 

CRP at various concentrations to test for pCRP to mCRP conversion. 

These incongruent effects can be attributed to differences among the denaturants 

used: GndHCl, urea, and SDS (Figure 11). SDS is a detergent that others have shown to 

denature without aggregation at high concentrations (74). However, at the low 

concentrations used in this work, it is anticipated that SDS works to stabilize the meta-

stable state of mCRP. Urea and GndHCl are chaotropic denaturants shown to have 

destabilizing effects on proteins (80, 81). Despite only having a slight structural 

difference, as seen in Figure 11, GndHCl and urea impact proteins differently. GndHCl is 

considered to be a strong chemical denaturant and was shown by others at limited small 

concentrations of GndHCl to stabilize aggregation with some proteins in the molten 

globule state, whereas urea did not (82). The strong denaturing properties and the distinct 

way that GndHCl interacts with CRP in comparison to urea can be seen in the results of 

these biochemical studies. 
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Figure 13. pCRP to mCRP conversion with highlighted amino acid residues. CRP monomer 

contains 6 tryptophan residues (navy blue), 13 lysine residues (magenta), 14 phenylalanine 

residues (yellow), and 2 cysteine residues to form the disulfide bond (green) (83). Hydrogen 

bonding between molecules is shown in cyan (47, 48). 

One assay often used to explore the two states of CRP is gel electrophoresis. 

Whether a 2D urea gel (84), reduced SDS (59), or the conditions used here for non-

denaturing PAGE, all results show a pCRP band that runs high and a mCRP band that 

runs low. Each gel (Figure 5C, Figure 5D, and Figure 7A) shows a native pentameric 

form that stays near the stacking portion (bands in Figure 5D have been cropped). Non-

denaturing gels separate proteins based on more than molecular weight, including protein 

shape and charge. The pCRP structure has salt bridges between subunits, hydrogen 

bonding, and van der Waals forces (85). Besides these interactions for pCRP, differences 

in how pCRP and mCRP run on a gel can be attributed to a change in the pI from 6.4 to 

5.4 (67). The gel conditions include pH values of 8.3 for the running buffer, 6.8 for the 

stacking portion, and 8.8 for the running portion of the gel, supporting mCRP having 
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more charge and running farther on the non-denaturing gel. Treatment of CRP with ≥ 2.5 

M GndHCl, ≥ 3 M urea/EDTA, or 0.01% SDS with heat all run close to the molecular 

weight for a CRP monomer (23 kDa) with non-denaturing PAGE. This demonstrates a 

clear transition and separation of pCRP and mCRP bands. 

The difference in the secondary structure of pCRP and mCRP forms (Figure 9A) 

indicates that mCRP is not merely a monomeric form of pCRP, but that it undergoes a 

structural change. Types of secondary structure that show up in the 210-230 nm region 

include α-helix and anti-parallel β-sheet (86). Native CRP has two antiparallel β-sheets 

and one α-helix per protomer (Figure 13) (22, 48). CD spectra of recombinant mCRP in 

comparison to pCRP have been reported to have a significant secondary structural 

change, mainly from β-sheet to α-helix, although no spectra was published (65). This 

structural change may be what gives mCRP its different binding properties, such as C1q 

binding. Comparing mCRP treated with dilute SDS and heat while at 80 °C and then after 

being cooled shows similar spectra (Figure 9B) concluding that when mCRP is made 

with dilute SDS and heat that it does not revert to pCRP upon cooling.  

Since no intermediates were observed in the gel (only modified and native), we 

used a two-state model to fit the GndHCl Trp fluorescence data (Figure 5A, black line). 

The intermediate states of fluorescence intensity can be assumed to be a mixture of 

folded and unfolded states, not proteins that exist in an intermediate state. However, the 

work of others (49) suggests that tetramers, trimers and dimers may exist under certain 

conditions. Our work suggests that only two states exist in a purified biochemical system. 
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Other conditions and the presence of other proteins may stabilize intermediate states that 

are not observed here.  

The results of the fit are what would be expected for a multimeric protein that has 

a slow transition. The change in free energy represents the conformational stability of a 

protein and most proteins have a value of 20-60 kJ/mol for stability of the native state 

above the unfolded state (87). CRP has a ΔG°N/U of 32 ± 12 kJ/mol. In comparison, a 

ΔG°N/U for α-lactalbumin, a smaller monomeric protein, was found by others to be 10.12 

± 0.33 kJ/mol (88) and the ΔG°N/U for phenylmethanesulfonyl α-chymotrypsin, a larger 

monomeric protein, was calculated from experiments with GndHCl to be 36.4 ± 1.8 

kJ/mol (originally in kcal/mol) (69). The ΔG°N/U of pCRP to mCRP based on the 

transition with GndHCl treatment indicates that pCRP requires a substantial energetic 

input to change forms. This is consistent with the work of others in requiring large 

amounts of heat or high concentrations of urea to biochemically make mCRP (55, 59). 

GndHCl appears to transition at a similar point with both Trp fluorescence and 

non-denaturing PAGE (Figure 5A, around 2.5-3 M). The observed Trp fluorescence 

transition for urea treated CRP is gradual (from 2 – 6 M) and over a much wider range 

than that observed in the gel (Figure 5B). This gradual transition suggests that 

conformational changes are still occurring that affect the Trp environment, but that these 

changes do not broadly influence the size or charge of the protein in a way that affects 

how it runs on a gel. The transition likely occurs over a larger range of urea 

concentrations because urea is a weaker denaturant than GndHCl. Each CRP monomer 

contains 6 Trp residues, which allows for comparison to a control sample of free Trp 
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(Figure 5A and Figure 5B, open circles). The lower fluorescence for CRP treated with 4 

M GndHCl than for free Trp at the same concentration suggests quenching. Tryptophan is 

sensitive to environment and many different interactions may contribute to a decrease in 

fluorescence including aggregation or quenching from nearby residues such as 

phenylalanine and lysine (89). There are two Trp residues with an adjacent phenylalanine 

and the CRP sequence contains 13 lysine residues per monomer (Figure 13). 

Conformational changes near the tryptophan residues are most likely the cause of the 

quenching and the lower than expected fluorescence. However, aggregation of CRP may 

also explain the low Trp fluorescence followed by an increase at higher concentrations of 

GndHCl due to stabilization and protein denaturation (Figure 6A). Each denaturant has a 

slightly different change in ANS fluorescence in comparison to free ANS in solution 

(Figure 10), which points to a difference in how the denaturants change the structural 

form of CRP. Urea and dilute SDS with heat treated CRP show a larger increase in ANS 

fluorescence, with the dilute SDS form being the largest change, indicating hydrophobic 

regions being exposed. A change in the amino acid residues exposed for mCRP is 

consistent with the observance of a mCRP specific aptamer (40, 90). 

The biochemical assays for both tryptophan and ANS fluorescence indicate that 

each denaturant affects pCRP differently. In order to determine which denaturant makes a 

biologically relevant mCRP form for in vitro experiments binding to the downstream C1q 

complement protein was analyzed with an ELISA (Figure 6). Paired, two-tailed Student’s 

t-tests revealed that the only forms with statistically significant binding to C1q were 

mCRP treated with 1.5 M GndHCl and with dilute SDS and heat. Although, many 
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conditions can cause monomerization and denaturation, only certain conditions leave 

CRP in a state that is capable of binding C1q. Denaturation with GndHCl is likely harsh 

and causes full unfolding, such that the sites needed for C1q binding are no longer intact. 

Instead, the protein binds a wide variety of other proteins, like BSA, likely in a non-

specific way, similar to what others have seen with acid treated CRP (62). In previous 

research, others have shown that while CRP treatment with 5 M GndHCl appears to have 

some monomeric properties (91), various concentrations of GndHCl failed to produce a 

mCRP form with neoantigenicity (67, 91). This discrepancy was contributed to different 

pH levels for the experiments, and in light of the research here, GndHCl appears to have 

a wide variety of effects on CRP. Urea/EDTA denaturation has a similar behavior with a 

trend towards binding C1q more than BSA at high concentrations of urea. Results from a 

fluorescent anisotropy assay confirm acid treatment also did not allow CRP to retain C1q 

binding abilities (40). This agrees with recombinant mCRP and not pCRP to C1q with 

surface plasmon resonance (55). Meanwhile, gentle unfolding with dilute SDS (0.01%) 

and heat retains binding to C1q (Table 2). 

In the literature, mCRP has been made with a wide variety of methods. Treatment 

with 8 M urea-EDTA is frequently used for pCRP to mCRP conversion (32, 38, 58, 66, 

84) and our results indicate that concentrations of urea >7 M are likely to follow the 

upward trend to make a CRP form with significant C1q binding. One method commonly 

used for cellular and animal experiments is recombinant mCRP (65, 71). The 

recombinant form has been shown by others to bind C1q and is considered similar to urea 

chelated mCRP in other assays (55, 65, 92, 93). The recombinant form remains mCRP 
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and does not revert back to pCRP (65). This is good for purification, however the method 

for expression and purification is time consuming (94). The method of making mCRP 

with 0.01% SDS and heating for 1 hour at 80 °C is consistent with functional relevance 

of C1q binding, in both this work and the work of others (40). The ability to maintain 

functional relevance when the mCRP treated with heat and SDS has been diluted points 

to a permanent change in the molecular structure, which, similar to recombinant mCRP, 

indicates that mCRP is unlikely to return to pCRP. Further studies of mCRP would 

benefit from using the SDS and heat preparation method due to the consistent C1q 

binding and simple technique. 
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Table 2. Summary of biochemical preparations of mCRP and their results. 

CRP Preparation Transition to 

mCRP 

Structural Notes C1q binding 

GndHCl Non-denaturing 

PAGE & Trp 

Fluorescence show 

transition around 

2.75 M 

Hydrophobic 

portions exposed 

(Trp and ANS 

Fluorescence) 

Only at 1.5 M 

GndHCl 

Urea/EDTA 3 M is where an 

mCRP band starts to 

show up in non-

denaturing PAGE 

Hydrophobic 

portions exposed 

(Trp and ANS 

Fluorescence) 

Trends toward 

binding at 7M, but 

not statistically 

significant 

SDS/Heat 0.01% SDS and heat 

for 1 hour at 80 °C 

has mCRP band 

Aggregates at 

higher CRP 

concentrations 

(DLS); CD spectra 

loses dip in 

secondary structure 

region 

0.01% SDS with 

heat has 

statistically 

significant C1q 

binding 

 

2.5 Summary 

C-reactive protein (CRP) is commonly measured as an inflammatory marker in 

patient studies for coronary heart disease, autoimmune disease, and recent acute 

infections. Because of the correlation of CRP to a vast number of disease states, CRP is a 

well-studied protein in medical literature with over 11000 references in PubMed (95). 

However, the biochemical and structural variations of CRP are not well understood. 

Conformations of CRP are thought to affect disease states differently, with a modified 

form showing neoepitopes and activating the complement immune response through C1q 

binding. Despite the broad interest in CRP, there is a noticeable gap of information in the 

biochemical literature regarding how different conformational states affect biochemical 

reactivity. In this work, we compare the unfolding of CRP using chemical denaturants 
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and identify which states of CRP bind a downstream complement immune response 

binding partner (C1q). We used guanidine HCl (GndHCl), urea/EDTA, and 0.01% SDS 

with heat to perturb the pentameric state. All treatments give rise to a monomeric state in 

non-denaturing polyacrylamide gel electrophoresis experiments, but only treatment with 

certain concentrations of denaturant or dilute SDS with heat maintains CRP function with 

downstream binding partners when measured using enzyme-linked immunosorbent 

assays. The results suggest that the final form of modified CRP and its ability to mimic 

biological reactivity depends on the preparation method. 
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CHAPTER THREE: CONFORMATIONAL CHANGES IN C‑REACTIVE 

PROTEIN AFFECT BINDING TO CURVED MEMBRANES IN A LIPID 

BILAYER MODEL OF THE APOPTOTIC CELL SURFACE1 

3.1 Introduction 

As established in the previous chapter, C-reactive protein (CRP) is an acute phase 

protein that is released to trigger the complement immune response with two known 

conformational states. These two states are native pentameric CRP (pCRP) and modified 

CRP (mCRP). The results from the above experiments established a protocol to make a 

biologically relevant form of mCRP. Research in this chapter applies these biochemical 

findings by making mCRP with 0.01% SDS and heating for 1 hour at 80 °C for use in 

lipid experiments. 

One main function of CRP involves binding to foreign or damaged material to 

signal degradation, allowing for removal of apoptotic cells to maintain self-tolerance. 

Native, soluble CRP (pCRP) is a homopentameric protein that binds to 

phosphatidylcholine (PC) lipids in a Ca2+-dependent manner (96). Each monomer has a 

binding site for PC (22, 48). Conversion of pCRP into a modified form results in 

exposure of neoepitopes, leading to different reactivity. Modified CRP (mCRP) then 

                                                 
1 Content for this chapter was modified from the journal article entitled “Conformational Changes in C-

Reactive Protein Affect Binding to Curved Membranes in a Lipid Bilayer Model of the Apoptotic Cell 

Surface” by Aml A. Alnaas, Carrie L. Moon, Mitchell Alton, Scott M. Reed, and Michelle K. Knowles 

published in 2017 in the Journal of Physical Chemistry B. The DOI is: 10.1021/acs.jpcb.6b11505. 
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binds downstream to binding partners, such as Factor H, C1q, and C4bp, which regulate 

the complement immune response (55). The modified form is often identified as a 

monomeric form, but multimers of CRP or other forms could also play a role in CRP 

activity (36). 

Beyond changes in molecular interactions due to conformational changes in CRP, 

conformational states have also been associated with different disease states. CRP levels 

have been linked to a wide variety of health issues, from cardiovascular disease (25, 97) 

and schizophrenia (98, 99), where high levels of CRP are related to negative outcomes, to 

autoimmune disorders, where increased CRP levels are likely protective (100–102). CRP 

is a marker of chronic inflammation (25, 48), and soluble pCRP is often measured to 

determine elevated levels that are correlated to health risks. However, it is thought that 

the modified form of CRP is the initiator of an inflammatory response in cells (30). 

Recent studies indicate that CRP plays a direct role in managing the inflammatory 

response to myocardial infarction, rather than just acting as a general marker of 

inflammation (103), with a monomeric form accumulating in plaque (104). Other recent 

work suggests that modified forms of CRP present in serum are related to obesity (60), 

and the monomeric form is also elevated in the eye during age-related macular 

degeneration (105). Despite the well-studied correlations between CRP forms and disease 

states, less is known about the molecular interactions of the different forms. 

One primary role of CRP in the body involves the recognition of damaged 

membranes, a process that depends on CRP−protein and CRP−lipid interactions. mCRP 

binds C1q, which activates the complement response (106, 107); meanwhile, binding to 
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C4bp (32) and Factor H4 attenuates the immune response. In an acidic environment, CRP 

undergoes conformational changes that expose hydrophobic portions of the protein, and 

then, CRP binds oxidized low-density lipoprotein particles, C3b, and Factor H with 

higher affinity (62). The monomeric form of CRP has also been shown to bind integrin 

proteins on the cell surface and increase inflammation (58). In almost all studies, mCRP 

has been shown to bind other proteins better than pCRP. Some of this reactivity is 

thought to be regulated via an intrinsically disordered domain, and mutations in this 

sequence dramatically affect CRP binding to downstream partners (108). 

Conformational changes in CRP clearly affect protein− protein interactions, but 

little attention has been given to how protein conformational changes affect lipid binding. 

It is interesting to note that phosphocholine is the predominant lipid head group in the 

outer leaflet of cell membranes yet CRP does not bind PC present on the surface of 

healthy cells. Beyond Ca2+, it is not clear what is needed for CRP to bind to lipid 

membranes. Past work has shown that lysophosphatidylcholine (lysoPC) (96, 109), 

oxidized lipids (50), and cholesterol are required for pCRP binding (92). LysoPC and 

oxidized PC are commonly found in damaged membranes, like those found on apoptotic 

cells, and may provide a distinguishing feature between healthy and unhealthy 

membranes (110). However, others have shown using mimics of low density lipoprotein 

particles that neither lysoPC nor oxidized PC are needed; instead, CRP can recognize PC 

when it is presented on very small (radius <15 nm) nanoparticles (38). Both lipid 

composition and the presentation of lipids on curved surfaces likely affect CRP binding. 
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To identify how CRP recognizes and binds to damaged membranes, we designed 

curved membranes containing lipids that are typically present on the cell surface (PC, 

lysoPC) using a nanoparticle patterned surface with a fluid, supported lipid bilayer 

deposited on top. Lipid fluidity was measured using fluorescence recovery after 

photobleaching (FRAP) methods. Using quantitative fluorescence microscopy, we 

observed that the shape of the membrane alters CRP binding, with positively curved 

membranes recruiting more CRP than flat membranes. However, curvature-dependent, 

lipid binding depends greatly on the conformation of CRP. mCRP prefers curvature 

(radius of curvature, ROC = 27−55 nm), but the soluble pentameric CRP does not bind 

more than the CRP antibodies alone. Addition of lysoPC increases the accumulation of 

CRP to both flat and curved membranes, recruiting mCRP and pCRP to curved 

membranes more than bilayers containing only phosphatidylcholine. Interestingly, the 

highly curved membranes (ROC = 27 nm) bind mCRP to a lesser extent when compared 

to lower curvatures (ROC = 55 nm). Overall, the mechanism by which CRP recognizes 

membranes depends on the conformation, lipid composition, and shape of the membrane. 

3.2 Method 

Experimental Contributions 

The majority of the research in this chapter was performed by Dr. Aml Alnaas. 

Mitchell Alton and Dr. Michelle Knowles contributed to image analysis coding and the 

processing of the images. Carrie Moon executed the dynamic light scattering experiment 

and a portion of the Biotin-X-DHPE experiment with some image analysis. 
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Materials 

CRP was purchased from Academy Bio-Medical Company (Houston, TX) and 

stored at 4 °C. Monomeric CRP was made from CRP by adding 0.01% SDS and heating 

at 80 °C for 1 h in buffer, as previously described (40). Soy L-α-lysoPC (lysoPC) and 1-

palmitoyl-2-oleoyl-sn-glycero-3-phosphocholine (POPC) were purchased from Avanti 

Polar Lipids (Alabaster, AL). Streptavidin labeled with Alexa 488, N-((6- 

(biotinoyl)amino)hexanoyl)-1,2-dihexadecanoyl-sn-glycero-3-phosphoethanolamine 

(Biotin-X-DHPE), red fluorescent (580/605) carboxylate modified fluospheres (d = 40 

and 100 nm), Marina Blue 1,2-dihexadecanoyl-sn-glycero-3-phosphoethanolamine (MB-

DHPE), and secondary goat anti-mouse immunoglobulin G with Alexa 488 were 

purchased from Thermo Fisher Scientific. Primary anti-C-reactive protein (C6 and D7 

mouse monoclonal antibodies) and mouse IgG monoclonal antibody were purchased 

from Santa Cruz Biotechnology. Buffers used were PIPES buffer (2 mM CaCl2, 30 mM 

PIPES, 140 mM NaCl, pH 6.4) or HEPES buffer (30 mM HEPES, 140 mM NaCl, 2 mM 

CaCl2, pH 6.5). All remaining chemicals were purchased from Sigma-Aldrich. 

Dynamic Light Scattering 

To determine that CRP was not self-aggregating in storage, dynamic light 

scattering (DLS) was performed on a DynaPro Plate Reader II with Dynamics version 7 

DLS software with a 384 well glass-bottom plate (Greiner Bio-One Sensoplate #781892). 

CRP was diluted to 500 μg/mL in PIPES buffer, and 50 μL each was placed into four 

wells for measurements. The plate was centrifuged at 200 rpm for 2 min. Settings for 

measurements were a 5 s acquisition time with autoattenuation at 25 °C. The solvent 
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setting for the system used was based on phosphate-buffered saline with a refractive 

index of 1.333 (at 589 nm for 20 °C) and a viscosity of 1.019 cP. Results are from three 

experimental days, where each measurement was in quadruplicate wells. The software 

used a Rayleigh Spheres model to fit the data, giving results for the hydrodynamic radius, 

% mass, and molecular weight (Figure 14). 

 

Figure 14. Dynamic light scattering of pCRP shows no aggregates. One example of a histogram 

of radii measured for pCRP is shown and representative of 12 measurements. 100% of the mass 

was less than 10 nm radius in all 12 samples measured. The average of 12 measurements was 4.4 

+/- 0.3 nm radius and 110 +/-20 kDa for molecular weight. The error listed is the standard 

deviation. 

Supported Lipid Bilayers 

Supported lipid bilayers were made following previous methods (8). Briefly, the 

supported lipid bilayer was formed over fluorescent polystyrene nanoparticles (44 or 100 

nm diameter Fluospheres from Life Technologies) deposited upon a flat glass surface (8 

well plate from Lab-Tek Chambered Borosilicate Coverglass System, Thermo Fisher) at 

a density of 0.01−0.05 nanoparticles/μm2. Liposomes were prepared by probe sonicating 

lipid films (0.125 mM lipids in PIPES buffer), and lipid bilayers were created by adding 
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100 μL of the sonicated lipid solution to each well followed by incubation at 37 °C for 1 

h. CRP (50 μg/mL) was incubated with the lipid bilayer at 37 °C for 2 h. Membrane 

fluidity was tested with FRAP using MB-DHPE, as described in previous work (8), and 

confocal microscopy was performed to measure colocalization between nanoparticles and 

the protein. For labeling of CRP, the primary and secondary antibodies were preincubated 

together in 1:1000 ratios for 30 min at room temperature. Preincubated antibody solution 

(100 μL) was added to each well for a total volume of 200 μL. Two different primary 

antibodies were tested (D7 and C6). 

Lipid films consisted of POPC, lysoPC, and MB-DHPE. The ratio of lipids 

included 0−3% lysoPC and 2% MB-DHPE, and the remainder was POPC. Specific ratios 

are stated in the text. For Biotin-X-DHPE samples, the ratio was POPC 99% and Biotin-

X-DHPE 1%. Alexa488-labeled Streptavidin was added at a final concentration of 25 

μg/mL. 

Confocal Microscopy 

A point-scanning confocal microscope (Olympus Fluoview) was used for FRAP 

experiments and for two-color imaging of red fluorescent nanoparticles and green 

fluorescent antibodies. For two-color imaging, the red and green fluorescence were taken 

sequentially to reduce bleedthrough with a 100× objective such that one pixel was equal 

to 124 nm. The red channel was excited with a 559 nm laser with an emission window of 

575−675 nm. The green channel was excited with the 488 nm line of an argon ion laser 

with an emission window of 500−545 nm. When FRAP was performed, a 405 nm laser 
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was used to excite and photobleach MB-DHPE, and emission was detected from 425 to 

475 nm.  

 

Figure 15. Supported lipid bilayers were created on a surface containing red fluorescent 

nanoparticles and then imaged after incubation with CRP. (A) Red fluorescent nanoparticle 

images mark sites of curvature. (B) Green fluorescently labeled protein (pCRP) is imaged 

separately. Red positions are located using a spot-finding algorithm and then cropped. Several 

positions are shown with circles. The same locations are cropped from the green image, shown in 

yellow circles, yielding pairs of images. (C) Three pairs of cropped images (3.1 μm wide). Panels 

r1−3 were cropped from A positions 1−3, and g1−3 were cropped from B. (D) The Pearson 

correlation coefficient is calculated for image pairs, and a histogram of all coefficients is plotted 

for pCRP at regions of curvature (black) and at random positions (magenta line). (E) A radial 

plot of the cropped images is calculated by averaging the normalized intensity of all pixels that 

are a certain distance from the center pixel, where a nanoparticle is located. Error bars are the 

SEM. 

Image Analysis 

Images were analyzed in MATLAB using location-guided colocalization 

methods, and the analysis is summarized in Figure 15. To find locations of curvature 

marked by red fluorescent nanoparticles, spot-finding methods were used based on 

freeware (111) that is designed from the methods of Crocker and Grier (112). Only the 

spot-finding portion of the code was used for this work. Locations were excluded if they 

were within 9 pixels of another location or within 12 pixels of the image edge. After 
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locations were identified, images were cropped from both red and green channels, 

yielding pairs of images. From the pairs of images, we measured first the distribution of 

Pearson’s correlation coefficients and second the average radial plot of the green cropped 

images. This was done by averaging all pixels that are a specific distance from the center 

pixel. For example, there are four pixels that reside one pixel (124 nm) away from the 

center, and these are averaged to give the second data point. Four pixels that reside 175 

nm from the center are averaged to give the third data point and so on. MATLAB code 

for the radial averaging function is available upon request. The intensity was normalized 

for each radial plot by dividing by an average radial plot of Alexa488 Streptavidin bound 

to Biotin-X-DHPE (SB-DHPE), which acts as a measure of the membrane surface area. 

The normalized intensity is termed ICRP/ISB‑DHPE. After normalizing to SB-DHPE, the 

peak height (amount bound to curved regions), offset (amount bound to flat regions), and 

sorting ratio, Ipeak/Ioffset, were calculated for samples where binding to the flat areas was 

observable above the background (113). The offset was calculated by averaging all 

values in the radial plot greater than 0.75 μm away from the center. All error bars are the 

standard error of the mean (SEM). 

The correlation function calculation was obtained from Dr. Justin Taraska (114). 

All other plots and significance testing were performed in GraphPad Prism (La Jolla, CA, 

U.S.A.).  

3.3 Results 

To determine whether or not CRP preferentially bound to curved membranes, 

supported lipid bilayers were created over a nanopatterned surface. Fluorescent 
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nanoparticles were deposited at a density of 0.01−0.05 nanoparticles/μm2 onto a cleaned 

glass surface. Then a bilayer was created on top using liposome deposition methods. CRP 

was incubated with the curved membrane surface and labeled with green fluorescent 

antibodies. Two-color, confocal imaging was performed to determine whether or not 

CRP bound to curved membranes. The red fluorescent nanoparticles mark locations of 

membrane curvature, as demonstrated in previous work (8). The green fluorescent 

channel relates the amount and location of CRP. The sample shown in Figure  contains 

CRP from human serum, the soluble, pentameric form commonly detected in medical 

diagnostics for inflammation. The lipid bilayer is composed of MB-DHPE (2%) and 

POPC (98%), a common lipid on the cell surface, with regions of curvature that have a 

radius of curvature (ROC) of 55 nm.  

To quantify imaging data, nanoparticles were identified using a spot-finding 

algorithm (112). Nanoparticles that were separated by more than 9 pixels from other 

nanoparticles and more than 12 pixels from the edge of the images were selected and 

cropped to 3.1 μm × 3.1 μm (25 × 25 pixel) images (Figure 15A). The same locations 

were cropped from the CRP channel (Figure 15B), and three examples of single cropped 

images are shown (Figure 15C). In CRP images, the intensity is variable with hazy 

fluorescence shown in g1, the background level of fluorescence in g2, and a fluorescent 

spot near a nanoparticle position in g3, whereas there is always a clear spot for the 

nanoparticle in images r1−3. Because nanoparticles are very bright relative to the 

background and monodisperse in both size and intensity, it is straightforward to automate 

the identification of curved membrane locations. The identification of regions of 
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curvature first allows us to automate our analysis using location-guided colocalization 

methods (8, 114, 115). This method of data analysis yields pairs of images, like those in 

Figure C, which can be further analyzed to obtain distribution information or averaged to 

obtain bulk information. 

From individual pairs of images, the Pearson correlation function was calculated 

to relate how similar the two images are, with −1 being images that are opposites and +1 

being those that are identical. The distribution of correlation values is plotted as a 

histogram, and very little is observed to be correlated in samples containing pCRP and 

curved POPC bilayers (Figure D, black bars). Random positions have a similar 

distribution (Figure D, magenta curve). The correlation function is useful for 

colocalization measurements, but the intensity information is lost; therefore, we 

performed another measurement that retains information related to the amount of protein 

present at nanoparticle regions. From the individual cropped, green (CRP) images (n = 

3297), a radial plot of the normalized intensity as a function of the distance from the 

center pixel was calculated (Figure E). This was done by averaging all pixels that are the 

same distance from the center, as described in the methods. After subtracting the 

background intensity, the intensity of samples lacking green fluorophores, data were 

normalized by dividing by the radial plot of SB-DHPE, which acts as a general 

membrane marker (Figure 16). In the radial plot, there are two pieces of information: the 

peak height (distance = 0 μm) and the offset (distance > 0.75 μm). The height is a 

measure of the amount of fluorescence at regions of curvature, and the offset is a measure 

of the fluorescence due to binding to flat membranes. These methods of analysis are used 
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to quantify how the lipid composition, protein conformation, and membrane shape 

separately affect CRP recognition of membranes. 

 

Figure 16. Radial plots used to calculate surface area normalized radial plots. A) The raw 

intensity measurement of mCRP (black dots) and pCRP (open circles) at regions of curvature 

with radii of 55 nm. B) The raw intensity measurement of Alexa488 labeled Streptavidin attached 

to Biotin-X-DHPE at 55 nm (black circles) and 29 nm (open circles). The background intensity of 

samples containing no green probes was subtracted from both A and B. C) Strep-Biotin-X-DHPE 

(SB-DHPE) at 55 nm (black circles) and 27 nm (open circles) was normalized by dividing by the 

average intensity for all pixels at a distance 0.75 of greater from the region of curvature. To 

calculate Figures in the text that contain normalized data, ICRP/ISB-DHPE, plots like those in A are 

divided by those in C based on the ROC. 

CRP Conformation Affects Binding to Curved Membranes 

The conformation of CRP affects binding to downstream proteinaceous partners, 

such as C1q and Factor H (25). Here we tested whether CRP conformation affects lipid 

binding to both curved and flat regions of the membrane. Supported lipid bilayers 

containing 98% POPC and 2% MB-DHPE were formed over top of a fluorescent 

nanoparticle patterned surface (ROC = 55 nm) and then incubated with CRP and CRP 

antibodies. The monomeric form of CRP (mCRP) was made as previously described (40). 

In this preparation, the tertiary structure remains intact, as demonstrated by the ability of 

mCRP to bind downstream partners of the complement immune response in a way that 

acid-treated or fully denatured CRP does not (40). Visually, mCRP shows high 

colocalization to nanoparticle sites and is also present in flat regions when compared to 

pCRP (Figure 17A). The average of the cropped, nanoparticle images shows a spot in the 



 

 55 

center, as expected. All images, except the red fluorescent nanoparticle image, are scaled 

identically and linearly for direct comparison. A spot appears in the center for mCRP, 

pCRP, and samples with no CRP (containing only antibodies, termed “none”) but not for 

samples where the surface has been blocked with bovine serum albumin (BSA) instead of 

CRP or when random regions are chosen instead of nanoparticle regions. 
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Figure 17. Monomeric CRP and pCRP were incubated on curved supported lipid bilayers and 

then imaged using confocal microscopy. (A) Average images of nanoparticles, mCRP, pCRP, 

samples with antibodies only (“none”), and BSA-blocked samples with antibodies and no CRP 

(“BSA”) have been cropped from regions selected from nanoparticle positions. Random positions 

were also selected and cropped. The images are all scaled linearly and identically. (B) The 

distribution of correlation coefficients for pairs of cropped images is measured for mCRP (black) 

and randomly selected positions in a pCRP sample (gray dashed line). (C) The average of the 

distribution is plotted for mCRP, pCRP, images with antibodies alone, and CRP at random 

regions instead of curved membrane regions. (D) From the images, the intensity is averaged 

radially and normalized to show the accumulation of mCRP (black circles) and pCRP (open 

circles). (E) The height and the offset are plotted for each radial plot. In all bar graphs, the error 

is the SEM. 
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To assess the interaction between CRP conformers and curved membranes 

further, correlation coefficients were calculated from pairs of cropped images (Figure 

17B). mCRP (black bars) and pCRP (Figure 15D) are clearly different; mCRP has a 

higher correlation to the nanoparticle positions, suggesting higher preference for 

curvature. The average correlation coefficient is 0.29 for mCRP (Figure 17C), and this is 

due to a large diverse distribution (Figure 17B). pCRP has an average of 0.03, which is 

similar to samples where no CRP has been deposited. Randomly chosen positions show 

near-zero correlation. 

Monomeric CRP accumulates at a curvature, and the amount of fluorescence at 

nanoparticle positions is quantified from the average radial distribution of the cropped 

images (Figure 17D). The normalized radial average shows that mCRP binds both flat 

regions, as observed by the offset, and nanoparticle regions, observed by the peak height, 

better than pCRP. pCRP has no measurable signal above background for flat regions and 

is similar in intensity to antibodies alone at regions of curvature, suggesting that pCRP 

does not bind membranes well. The increase in fluorescence at curvature relative to the 

background is shown as a bar graph of the peak height and offset intensity for mCRP, 

pCRP, and no CRP present (Figure 17E). The height is the first point in the radial curve. 

The offset is measured from the average for all distances from 0.75 to 3.1 μm away from 

the center, a distance greater than the spread of the intensity in the center but less than the 

nearest-neighbor distance. In Figure 17E, the average peak height and offset of all 

cropped images are plotted, and both are higher for mCRP relative to those for pCRP. 
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Lysophosphatidylcholine Increases CRP Binding to Membranes 

The presence of lysoPC has long been known to enhance CRP binding to the 

surfaces of artificial bilayers (96). To investigate how changes in the chemical 

composition affect CRP binding, supported lipid bilayers that contained 3% lysoPC, 2% 

MB-DHPE (to measure fluidity), and 95% POPC were created over a nanopatterned 

surface where both flat and curved membrane regions were measured simultaneously. 

The presence of lysoPC increased the Pearson correlation coefficient for both pCRP and 

mCRP (Figure 18A, B). In both cases, there was an increase in the distribution at larger 

coefficients. In Figure 18C, the average correlation coefficient is shown relative to 

random positions, and a dashed line indicates the position without lysoPC (shown in 

Figure 15D and Figure 17B). There is an increase by approximately 0.1 for both forms of 

CRP, suggesting that lysoPC enhances binding to curved regions. 
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Figure 18. CRP was incubated with lysoPC containing membranes (LysoPC: POPC: MB-DHPE 

at a 3:95:2 molar ratio) that had regions of curvature (ROC = 55 nm). From cropped images, the 

Pearson correlation coefficient was calculated for (A) pCRP (black bars) and (B) mCRP (black 

bars). The gray dashed line in both plots denotes the distribution of the correlation coefficient of 

protein to regions of curvature in randomly selected positions in pCRP samples. (C) The average 

value of the correlation function distribution is shown with the SEM for both nanoparticle and 

random positions. The dashed line shows the average value when lysoPC is not in the membrane 

and nanoparticle positions are selected. (D) Normalized radial averages of mCRP and pCRP 

binding to sites of curvature. mCRP and pCRP binding to lysoPC bilayers (black circles and 

white circles, respectively), mCRP (black dashed line), and pCRP (gray dashed line) on bilayers 

without lysoPC. (E) The peak height and offset are plotted side by side for mCRP, pCRP, and no 

CRP. (F) The difference between the height and offset, ΔIntensity, for mCRP (solid) and pCRP 

(striped) with and without lysoPC. 

To determine how much CRP accumulates at nanoparticle regions when lysoPC is 

present, the intensity of CRP fluorescence was quantified (Figure 18D−F). The height of 

the radial plot of mCRP increases only slightly, as shown in Figure 18D, where the black 

dashed line is the radial plot without lysoPC and the black circles are that with lysoPC. 

The height of the radial plot of pCRP at nanoparticles increases approximately 4-fold, as 

shown in Figure 18D, E, where the gray line is the radial plot of pCRP without lysoPC 
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and the open circles depict the radial plot in the presence of lysoPC. The difference in 

normalized intensity between flat and curved regions, ΔIntensity (Figure 18F), is 

significantly higher (p < 0.05) for both mCRP and pCRP, indicating that lysoPC serves to 

increase binding of all forms of CRP to curved regions more so than that to flat regions 

but affecting pCRP more than mCRP. 

  



 

 61 

 

 

Figure 19. CRP was incubated with supported lipid bilayers with a smaller nanoparticle support 

(d = 44 nm, ROC = 27 nm) and imaged using confocal microscopy. Lipid bilayers contained 98% 

POPC and 2% MB-DHPE. (A) Pearson correlation coefficient distribution for pCRP and 

nanoparticle images (N = 1574), on samples containing a ROC = 27 nm. (black). (B) Pearson 

correlation coefficient distribution for mCRP and nanoparticle images (N = 1368) on samples 

containing a ROC = 27 nm (black). The gray dashed curves in both (A) and (B) are from 

randomly selected positions in a pCRP sample. (C) Average of the correlation coefficient as a 

function of curvature. (D) The peak height (normalized intensity at d = 0 μm) and offset 

(normalized intensity at d = 0.75−3.1 μm) for mCRP at 27 and 55 nm were measured from the 

normalized radial plot. Error bars are the SEM. 



 

 62 

Membrane Shape Affects CRP Binding 

The shape of a membrane has been shown to affect protein binding for a variety 

of membrane-associated proteins, such as BAR domains (116), amphipathic helices (16, 

117), and lipid-anchored proteins (118, 119). By decreasing the size of nanoparticles used 

as a template for the supported lipid bilayer, higher curvatures (ROC = 27 nm) were 

examined. The Pearson correlation coefficient distribution (Figure 19A, B) was affected 

by membrane shape for both conformations. The distribution shifted to slightly higher, 

more colocalized coefficients for pCRP (Figure 19A), whereas the shift was to lower 

coefficients for mCRP (Figure 19B). The average correlation coefficients for both mCRP 

and pCRP are shown (Figure 19C), and a statistical difference in colocalization is 

observed for both conformations. However, the change in pCRP accumulation is small, 

with pCRP slightly favoring higher curvatures relative to the large change in mCRP 

accumulation, where mCRP favors lower curvatures. The results were similar when 3% 

lysoPC was included in the bilayer (Figure 20). 

 

Figure 20. CRP recruitment to curvature with a smaller nanoparticle support (d = 44 nm, ROC = 

27 nm) was measured using confocal microscopy. Lipid bilayers contained 95% POPC, 3% 

LysoPC, 2% MB-DHPE A) The Pearson’s correlation coefficient distribution for mCRP and 

nanoparticle images at a ROC of 25 nm (black bars). B) The Pearson’s correlation coefficient 

distribution for pCRP and nanoparticle images at a ROC of 25 nm (black bars). In both plots, the 

gray curve is the distribution of correlation values for randomly selected positions. 
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The accumulation of mCRP at regions of curvature was quantified by comparing 

the binding of mCRP to flat regions (offset) to the binding of mCRP to regions of 

curvature (peak height) after normalizing the radial plots with SB-DHPE (Figure 

19D,Table 3). The sorting coefficient was calculated by dividing the normalized peak 

intensity by the intensity measured in the offset, and these coefficients are summarized in 

Table 4. Sorting coefficients were not calculated for pCRP because the binding of pCRP 

to flat regions was close to 0 after background subtraction and not greater than the 

binding of free antibody to flat membranes. 

 
Table 3. Summary of mCRP and pCRP Accumulation at Curved and Flat Regions a  

 Iflat Ipeak @ ROC 55 

nm  

Ipeak @ ROC 27 

nm 

mCRP  108 ± 3  844 ± 17  119 ± 4 

pCRP  4 ±2  59 ±6  56 ± 2 

mCRPlyso  65 ± 3  893 ± 17  n/a 

pCRPlyso  29 ± 2  289 ± 11  n/a 
aThe intensity was normalized by dividing by the intensity of SBDHPE, as described in 

Figure . 

 

Both the increase in intensity at the peak relative to the flat regions and the 

average correlation coefficient convey that mCRP collects at larger nanoparticles (lower 

curvature) at a density greater than the accumulation at smaller nanoparticles (higher 

curvature). However, pCRP binds membranes minimally, unless lysoPC is present, in 

agreement with the work of others (96, 120). The shape of a membrane clearly affects 

CRP binding, and this depends on the form of CRP. The mechanism by which mCRP and 

pCRP interact with membranes is likely different. 
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Table 4. Sorting Coefficients for mCRP a 

 ROC 55 nm  ROC 27 nm 

mCRP 7.8 1.1 

mCRPlyso 13.7 n/a 
aSorting coefficients, Ipeak/Ioffset, are determined by dividing the normalized peak 

intensity by the normalized flat intensity. 

 

3.4 Discussion 

The physiological activity of CRP depends on its ability to bind membranes and 

trigger an immune response. Others have demonstrated that the conformational state of 

CRP affects protein binding (24, 32, 58) and the subsequent regulation of an 

inflammatory response by the complement cascade (107), but little is known about how 

lipid interactions are affected by alterations in CRP conformation. In our work, we 

measured CRP accumulation on membranes, focusing on a commonly prepared 

monomeric form and the native, pentameric form. The ability of the different forms to 

bind membranes of varying shapes and lipid composition was examined using a 

nanoparticle- based assay that allows for separate adjustment of the shape and chemical 

composition. The following conclusions can be drawn from the data to further 

characterize the mechanism by which CRP identifies damaged membranes in the body. 

Conformation of CRP Affects Binding to Curvature. The modified form of CRP 

binds lower curvatures (ROC = 55 nm) more effectively than pCRP (Figure 15 and 

Figure 17). We hypothesize that the mechanism by which mCRP binds curvature better 

than pCRP is driven primarily by hydrophobic regions of CRP being exposed once the 

pentamer begins to dissociate (36, 92, 121). The faces that connect the protomers in the 

pentameric form are enriched in hydrophobic amino acids that preferentially insert into 

membranes or aggregate. Other proteins, such as amphipathic helices, preferentially 
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insert into curved membranes through hydrophobic interactions with the defect sites that 

form as a lipid membrane bends around a curved surface (118). These defect sites are 

thought to allow exposure of the hydrophobic tails to the surrounding aqueous solution 

and potentially interact with hydrophobic proteins. However, defect site binding to 

membranes alone cannot explain the clear preference that mCRP has for lower curvatures 

over higher curvatures and flat membranes (Figure 19, Table 4). The current model of 

defect site binding suggests that more defect sites exist as a membrane bends with higher 

curvature. Therefore, defect site binding proteins, like lipid-anchored proteins and 

amphipathic helices, bind higher curvatures better than lower curvatures (16, 118, 119). 

Defect site-based curvature sensing predicts a linear dependence of the sorting ratio 

(Ipeak/Ioffset) on 1/ROC (122). This trend differs from the curvature preference of mCRP 

binding, where mCRP prefers moderate curvature over high or flat regions. The driving 

force in defect site binding is the reduction in free energy of the system unless other 

mechanisms (described below) are acting on the system to create an optimal curvature for 

protein binding. 

One mechanism by which a specific or optimal shape preference comes about is 

from a 3D protein structure that has an intrinsic curvature, like a BAR domain (116) or a 

clathrin coated pit (123). These larger structures act as a driving force for sorting of the 

protein at sites of curvature. These structures then prefer lipid membranes that match in 

shape to their intrinsic curvature. mCRP could form larger oligomers on membranes that 

give rise to structures with a specific curvature preference. It is possible that higher-order 

structures are what drive CRP binding and these structures form better on membranes 
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with a radius of curvature of 55 nm as opposed to 27 nm. A second mechanism by which 

specific shapes of membranes could be sensed involves molecular crowding. For 

example, the protein CALM, a clathrin adapter protein, has a preference for binding 90 

nm diameter liposomes (124). CALM shows this preference by using an amphipathic 

helix to insert into defect sites, and CALM itself is not thought to form higher-ordered 

structures. Instead, the packing into defect sites is limited by molecular crowding of the 

rest of the protein as it binds only on one leaflet. In the same way, mCRP could insert 

hydrophobic portions into defect sites but be limited from fitting more due to crowding. 

We see no direct evidence of higher-ordered structures in our assay, but curvature sensing 

of a specific size could arise from a multimeric mechanism or a mechanism by which 

molecular crowding limits the protein density at higher curvatures. 

An alternative interpretation for the observation of specific curvature sensing in 

the data could arise from the conformational state of the protein being different when 

bound to 55 nm curved sites than higher curvature membranes. It is possible that the 

conformational state of CRP exposes neo-epitopes when bound to 55 nm curved 

membranes and these neoepitopes have a higher affinity to antibodies. It is well-known 

that different CRP conformers bind differentially to CRP antibodies (125, 126) and CRP 

conformation is affected when directly labeled (59). If the observed accumulation at 

curvature is an effect of protein state, this would be physiologically relevant to the 

inflammation field, where the state of CRP at sites of inflammation, like plaque, is 

unclear. Changes in conformational state would likely affect downstream binding in the 

complement cascade and with cell surface receptors, as others have shown when 
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comparing mCRP and pCRP (24, 127). Further studies of CRP reactivity to C1q, C4bp, 

and Factor H while on a wide range of curved membranes could elucidate whether these 

CRP clusters have unique physiological relevance and what the optimal curvature is for 

CRP clustering and/or neoepitope exposure. 

In sharp contrast to mCRP, we see a lack of pCRP binding to curvatures 

containing only POPC (Figure 15 and Figure 17). This agrees with the fact that pCRP 

does not bind healthy cells and does not accumulate well on PC containing liposomes 

(96, 104, 120). However, once the membrane curvature was increased (ROC = 27 nm), 

pCRP exhibited a slightly higher accumulation at curved membranes regions (Figure 

19A−C). This is in agreement with past work on CRP (38) where very high curvatures 

(ROC = 10−15 nm) were tested and shown to bind pCRP better than lower curvatures 

(ROC = 20−35 nm). However, in this past work, the lower curvatures likely bound pCRP 

to a lesser extent, below the detection level for the binding assay used, based on the fact 

that CRP was activated in some way to be able to bind C1q after incubation with curved 

membranes (38). All binding was Ca2+-dependent, indicating that the pCRP/PC 

interaction was likely through binding of the PC moiety as opposed to an interaction with 

the lipid tails. Although we observe a small increase in pCRP colocalization at membrane 

locations with a ROC of 27 nm relative to 55 nm, it is likely that pCRP binds better to 

higher curvatures than those measured here, like others have shown. 

Lipid Composition Affects Binding to Membranes 

The membrane association of pCRP is also enhanced by changes in the lipid 

composition. Once lysoPC is added to the lipid bilayer, pCRP binds at a higher density to 
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curved regions (Figure 18). This is consistent with the fact that CRP does not bind 

healthy cells that contain lipids similar to POPC. Damaged membranes often contain 

modified lipids, and modifications that convert PC to lysoPC on the cell surface are 

required for recruiting CRP to cells or particles that need clearance (96, 120). In our 

work, lysoPC enhances binding more at curved regions than on flat regions, as shown by 

the increase in height of the radial plots in Figure 18D−F. This could be due to the 

accumulation of single-tailed lipids, like lysoPC, at sites of curvature (8); there is a higher 

density of lysoPC at the curved regions to associate with CRP. Others have suggested 

that lysoPC introduces irregularities into artificial lipid bilayers (96) and that these 

features are essential to binding pCRP. 

The presence of lysoPC affects pCRP more than mCRP, increasing the 

accumulation by 4-fold as opposed to a 10% increase at curved membranes (Figure 18F). 

This suggests that mCRP associates in a way that does not depend on binding lysoPC, 

whereas pCRP association does. pCRP likely interacts through head group interactions 

within the Ca2+-dependent PC binding site, as others have observed on highly curved 

membranes lacking lysoPC (38). However, the mechanism by which pCRP binds 

membranes may be different when lysoPC is present. Recent work suggests that pCRP 

has a non-Ca2+-dependent, lysoPC binding site, on the side opposite the PC binding site 

(109). This site could be lost upon monomerization, leaving mCRP to interact with 

membranes primarily through hydrophobic insertion. 
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3.5 Summary 

In summary, we utilized a nanopatterned substrate to introduce curvature into 

continuous lipid bilayers for quantitative image analysis of CRP−lipid interactions. One 

major advantage of this assay is the ability to separately tune chemical composition and 

membrane shape (8). This work demonstrates that the conformational state of CRP 

affects lipid binding. Monomeric CRP readily associates with membranes, favoring sites 

of curvature over flat regions. Native pCRP does not easily associate with membranes 

until the curvature is high, likely higher than that tested here, or until lysoPC is 

introduced. CRP likely recognizes damaged lipidic materials through a mechanism that 

combines PC head group binding by pCRP and membrane insertion into defect sites, 

which stabilizes the conformational conversion to mCRP. Both of these types of 

interactions are potentially strengthened at sites of curvature and could aid in CRP’s role 

in recognizing damaged membranes in the body.  
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CHAPTER FOUR: NOVEL MODIFICATIONS TO A NANOPARTICLE 

PATTERNED SUBSTRATE ASSAY 

4.1 Introduction 

Experiments studying binding of CRP to curved membranes show the ability of 

the nanoparticle patterned substrate assay outlined above to be applied to studying a 

system where peripheral membrane proteins bind to a membrane. Other systems where 

membrane curvature may play a role in protein binding include BAR domains and 

membrane trafficking (16, 124, 128). The method for a membrane curvature assay 

published by our lab involves first depositing nanoparticles for a patterned substrate 

followed by a deposition of liposomes to form a supported lipid bilayer (8). Others have 

shown the advantages of using colloidal lithography to deposit nanoparticles, which can 

be followed by a layer of silicon dioxide through sputter coating (129). This chapter 

focuses on experiments that combine these two methods to allow for the reuse of the 

patterned substrate as well as the ability to use it with cellular experiments. 

A challenge with sputter coating is that a flat coverglass must be used. The 

addition of fabricated silicone or 3D printed chambers to the coverglass system allows for 

less volume. 3D printing is becoming more accessible, as seen by the dedicated website 

of the NIH 3D Print Exchange (https://3dprint.nih.gov/). There are currently no 3D 

printing files for chambers available, so the chambers designed here will be a valuable 

addition and option for scientists. 
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In addition to being a patterned substrate, the use of fluorescent nanoparticles has 

the added functionality to be able to be used for colocalization analysis beyond simply 

inducing curvature. Inducing curvature into cells is a new concept and could be useful for 

studying processes like endocytosis and exocytosis to see if certain proteins sort to sites 

of curvature. By sputter coating a thin layer of silicon dioxide on top, the nanopatterned 

substrate is not only reusable, but also works with many assays, such as atomic force 

microscopy (AFM) and colocalization analysis using supported lipid bilayers and a 

fluorescent probe. In depth colocalization analysis of different lipid bilayer compositions 

are shown here. 

4.2 Method 

Experimental Contributions 

Alan Weisgerber did the deposition and melting of most of the nanoparticle 

patterned coverglass used here. Dr. Xin Fan (University of Denver, Physics and 

Astronomy) performed the sputter coating. Dr. Michelle Knowles and Mitchell Alton 

contributed the majority of the MATLAB code. All other experiments and data analysis 

were completed by Carrie Moon. 

Materials 

Attofluor cell chambers (Invitrogen A-7816) are stainless steel, autoclavable 

holders for 25 mm round coverglass. These were used for deposition of 0.1 µm 

fluorescent polystyrene nanoparticles (Thermo Fisher fluospheres) for cellular and 

supported lipid bilayer imaging experiments. Yellow-green fluospheres (Thermo Fisher 
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F8803) were used for AFM experiments and red fluospheres (Thermo Fisher F8801) 

were used in the other experiments performed here. 

Silicone Rubber Chambers 

Silicone rubber baking mats were cut into a shape with four chambers to fit on top 

of a coverglass inside the Attofluor chamber. The overall shape was designed to have 

four circular chambers with a small triangular notch near the top (for orientation when 

imaging). Silicone rubber was cut using an electronic die cutting machine (Cricut 

Personal/V1). Superglue was used to adhere the silicone rubber to the glass with a semi-

permanent bond. Experimental working volume was 20 µL per well with an overall total 

volume of 30 µL maximum for a droplet shape. This allows for washing off liposomes 

with the addition and removal of 5 µL. Due to the small volumes, some evaporation 

occurred during lipid incubation and extra buffer was added (5 µL) as needed. 

 

Figure 21. Chambered holders designed for different well volumes. A) Silicone rubber miniature 

chambers have a 20 µL working volume. B) Walled 3D printed chambers have a 75 µL working 

volume. 
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3D Printed Chambers 

A chambered structure with walls was designed in Autodesk Fusion 360 software 

to have 4 pie shaped wells. Wells were designed to fit on top of a coverglass after it has 

been inserted into an Attofluor holder. 3D prints were made using a Prntrbot Plus (Model 

1504) with 1.75 mm polyethylene terephthalate (PETG) filament (Maker Geeks HD 

Black Glass). PETG plastic was chosen over acrylonitrile butadiene styrene (ABS) or 

polylactic acid (PLA) filament due to strength, low odor, and environmentally friendly 

properties. Prints were done using Ultimaker Cura 15.04 software 

(https://ultimaker.com/en/products/cura-software) with settings of 50% fill density, 

0.1984 mm layer height, 0.8 mm shell thickness, 40 mm/s speed. The printing 

temperature was optimized to 240 °C. 3D prints were glued on with silicone elastomer 

epoxy (Sylgard 184, used at a 10:1 ratio) or superglue for a semi-permanent bond or with 

Gorilla brand epoxy for a permanent bond. Once 3D print was placed, the epoxy or glue 

was allowed to set at appropriate curing times and temperatures (10-20 minutes at room 

temperature or 1 hour at 80 °C). The prints with coverslips attached were handled with 

tweezers and the underside was inspected for areas that did not seal. Fresh epoxy or glue 

was pushed under in those areas with a toothpick and allowed to cure again. Total 

maximum volume in each well is 100 µL, with a working volume of 75 µL, allowing for 

the addition of 25 µL for a liposome wash. 

Nanoparticle Patterned Coverglass 

In the Attofluor chamber, nanoparticles were deposited on a cleaned 25 mm round 

coverglass using previously established protocols and concentrations (see Appendix A) 
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(8). Nanoparticles were allowed to incubate for 15 minutes at room temperature before 

being placed in a 100 °C oven for 10 minutes. After heating, the coverglass is rinsed 5 

times with deionized water. 

 

Figure 22. Illustration of modification to nanopatterned substrate for curvature assays. 

Fluorescent nanoparticles (radius 50 nm) have been used previously to induce curvature with 

supported lipid bilayers. The method outlined here has the addition of heating to melt the 

nanoparticles slightly and of a 30 nm silicon dioxide coating. Figure not drawn to scale. Lipid 

bilayers are approximately 4 nm. 

Nanoparticle patterned coverglass was attached to sputter coat stage with Kapton 

tape. A Phase II J sputter coater (AJA International, Inc.) was used to deposit 30 nm of 

silicon dioxide (Figure 22, 2300 s at 0.13 Å/s deposition rate). Some coverglass had the 

addition of a 5 nm titanium coating (80 s at 0.63 Å/s) on top of the silicon dioxide. 

Atomic Force Microscopy (AFM) 

AFM of nanoparticles sputter coated with both silicon dioxide and titanium was 

performed at the University of Denver using an Asylum Research MFP-3D instrument 

with AR v13 software (Bruker probe MSNL-10, Figure 25). Image analysis and 

measurements were done with Gwyddion software. 

AFM was also done with a Bruker Resolve instrument located at Colorado State 

University in Fort Collins, CO. For these experiments, a ScanAssyst Air probe was used 

and analysis was done with Nanoscope Analysis 1.8 software. Samples tested had 30 nm 

silicon dioxide and 5 nm titanium sputter coating (Figure 25) or no sputter coating at all 
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(just melted nanoparticles, as seen in Figure 26). Gwyddion software was used to 

calculate the roughness of the sputter coated flat region. 

Cell Culture Experiments 

PC-12 gr5 cells (ATCC) were grown in T-25 or T-12.5 flasks (Nunclon) with 

Dulbecco’s Modified Eagle Media (Life Technologies 11965) containing 5% fetal calf 

serum (Fisher SH3007403), 5% horse serum (Fisher SH3007203), and 100 µg/mL each 

of penicillin and streptomycin (Fisher ICN1670049). Cells were split or plated when at 

80% confluence with pipetting up and down to break up clumps. Versene (Thermo Fisher 

15040066) was used to detach cells from flasks. Polylysine (Sigma PL4707) was used to 

coat the coverglass with an incubation time of 20 min at room temperature. Coverglass 

was then washed 3 times with sterile PBS (Life Technologies 14040) prior to plating 

cells. Cells were allowed to adhere and grow overnight. Manufacturer’s instructions were 

followed to stain membranes with Cellmask in green or deep red (Life Technologies 

C37608 or C10046). 

Supported Lipid Bilayer Analysis 

The protocol used here was modified from a previously published method (8) and 

a detailed version of that protocol can be found in Appendix A. The modifications 

included no Hellmanex and no deposition of nanoparticles (already deposited and sputter 

coated). Each experiment starts with washing the sputter coated substrate with buffer (15 

mM HEPES, 100 mM sodium chloride, 2 mM calcium chloride, pH 7.4). If using 

customized chambers, the volume used in the working volume listed above or a volume 

of 500 µL, if using only the Attofluor chamber. Lipid incubation and rinsing off 
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liposomes is also the same except for the volumes being chamber size dependent. After 

imaging is over, wells are cleaned for reuse. Cleaning steps include removal of lipid-

buffer solution, incubating with the appropriate maximum volume of 1% SDS for 5 

minutes, and washing 3-4 times with deionized water. Wells are left empty, allowed to 

dry, and stored in an individual covered and labeled container for later use. The 

containers that were found to work well are two small weigh boats taped together to form 

a clam shell configuration. Lipid structures in the compositions used here are illustrated 

below. Lipid film compositions contained 92-98% POPC, 0-5% cholesterol, 0-1% 

DOPE-PEG 2000 and 2% MB-DHPE or 2% Fluorescein DHPE (FL-DHPE). All lipids 

were purchased from Avanti Polar Lipids, with the exception of MB-DHPE and FL-

DHPE which were purchased from Thermo Fisher Scientific. 
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Figure 23. Lipid Structures. A) POPC, B) Cholesterol, C) PEG-DOPE, D) MB-DHPE, E) FL-

DHPE 

Confocal Microscopy 

A point-scanning confocal microscope (Olympus Fluoview FV1000) was used for 

cellular experiments. For two-color imaging, the red and green fluorescence were taken 

sequentially to reduce bleedthrough with a 100× oil objective such that one pixel was 

equal to 99 nm. The red channel was excited with a 559 nm laser with an emission 

window of 575−675 nm. The green channel was excited with the 488 nm laser with an 

emission window of 500−545 nm.  

Another point-scanning confocal microscope (Olympus Fluoview FV3000) was 

used for the supported lipid bilayer experiments. For two-color imaging, the red and 
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green fluorescence or red and blue fluorescence were taken sequentially to reduce 

bleedthrough with a 100× oil objective such that one pixel was equal to 99 nm (zoom 

2.5). The red channel was excited with a 559 nm laser with an emission window of 

575−675 nm. The green channel was excited with the 488 nm laser with an emission 

window of 500−545 nm. The blue channel was excited with a 405 nm laser and emission 

was detected from 425 to 475 nm. 

Data Analysis 

Confocal images were split by channel and exported into TIFF files using ImageJ 

(http://imagej.nih.gov/ij/) or Olympus FV FV31S-SW software. Detailed steps for 

colocalization analysis in MATLAB are outlined in Appendix D. Colocalization analysis 

of non-cell nanoparticles resulted in false positive curvature sensing, so the second 

method outlined in Appendix D was used for cell data. Fluorescence recovery after 

photobleaching (FRAP) analysis employed the method outlined in Appendix B. 

4.3 Results 

Using a combination of already established methods, a reuseable nanoparticle 

patterned substrate was made (8, 9, 129, 130). In order to induce curvature into cells for 

studying proteins that go to sites of curvature, it was first necessary to have an assay that 

allowed cells to grow on top of a patterned surface. Initial attempts to grow cells on top 

of melted nanoparticles resulted in cellular uptake of the fluorescent nanoparticles 

(Figure 24A). By sputter coating the melted nanoparticles with 30 nm of silicon dioxide 

(Figure 22), the cells are now capable of growing on top of the patterned substrate Figure 

24B, C). 
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Figure 24. Cells invaginate melted nanoparticles prior to sputter coating. A) PC12 cells grown 

on top of melted nanoparticles show fluorescence in the z-stack of the nanoparticle channel. B) 

PC12 cells grown on top of melted and silicon dioxide sputter coated nanoparticles have a 

distinct layer of fluorescence along the coverslip of the nanoparticle channel. C) The 

corresponding z-stack for the Cellmask channel highlighting the cell membrane. 

AFM was used to determine the size and shape of the melted and sputter coated 

nanoparticle pattern substrate. The titanium sputter coat was added to enhance the ability 

of the AFM probe to sense the surface in tapping mode (Figure 25). Data contains a large 

amount of noise. Line scans indicate widths of 300-400 nm and heights of 80-300 nm. A 

Confocal AFM instrument was used to measure sizes of melted nanoparticles with no 



 

 80 

sputter coating resulting in heights of 70-80 nm for the melted 100 nm nanoparticles 

(Figure 26). This same instrument was used to measure the roughness of flat region after 

30 nm silicon dioxide and 5 nm titanium coatings. The majority of the roughness values 

are within ±10 nm (Figure 27).  

 

Figure 25. Atomic force microscopy (AFM) of melted and sputter coated nanoparticles. 100 nm 

nanoparticles were melted and then sputter coated with 30 nm of silicon dioxide and 5 nm of 

titanium. 
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Figure 26. AFM results for melted nanoparticles. Nanoparticles start out as 100 nm Fluospheres 

and have a height near 70 nm after melting. 

 

 

Figure 27. Calculated roughness of 30 nm silicon dioxide and 5 nm titanium coated glass 

coverslip flat region from an AFM image. 

Initial results from colocalization analysis with cellmask membrane staining 

appeared to show colocalization of membrane material with sites of curvature. This is 

expected due to the increase of surface area if the membrane wraps around the curved 

region (data not shown). After analyzing a control, it was discovered that this was a false 

positive due to the bright regions around the edges of the cell image. By only analyzing 
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the nanoparticles on the inside of the cells, the reprocessed data shows a lack of curvature 

sensing by the cell membrane (Figure 28, Appendix D). 

 

Figure 28. Representative radial average of colocalization analysis of PC12 cell membranes 

labeled with cell mask on top of sputter coated, melted nanoparticles. 

For an in vitro analysis of the ability for membranes to curve around the 

nanoparticle patterned substrate, supported lipid bilayers were used with combinations 

that contained cholesterol and a polyethylene glycol (PEG) polymer attached to the lipid 

head group (Figure 23). PEG was added to mimic the extracellular matrix, which has an 

impact on membrane dynamics (131). Cholesterol was added to mimic cellular 

membranes. Cellular membrane composition varies by cell type, leaflet side, and even 

regions of the cell (Figure 29 and Figure 30). One example of this variation has been 

recorded by others with two opposite sides of an intestinal cell (apical and basolateral) 

containing different compositions (132). The phospholipid type as well as the amount of 

cholesterol varies among cellular organelles as seen in Table 5. 
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Figure 29. Plasma membrane composition of two regions of intestinal cells are representative of 

the variation among cell membrane compositions and the high amount of cholesterol present 

(132). 

Table 5. Lipid and cholesterol compositions vary with cellular organelles (133). 

 % of total phospholipids Ratio 

Membrane PC PE PI PS Chol/PS 

Endoplasmic reticulum 55 30 15 3–5 3 

Golgi complex 50 15 10 5 4 

Early endosome 47 23 8 8.5 - 

Late endosome 48–49 18.5–20 4–7 2.5–3.9 - 

Mitochondria 40–46 30–35 5–10 1 10 

Plasma membrane 42 25 3 12 8 

 

Fluorescent lipids were used to visualize membranes for colocalization. FL-DHPE 

has been shown by others to sense curvature and MB-DHPE was used as our control 

(118). Radially averaged colocalization data was normalized to an average of the tail 

region (0.75 µm or farther away from the center of the pixel). Results show that the lipid 

mixture has an impact on the curvature sensing ability of the fluorescent dye (Figure 30).  

glycosphingolipid
37%

phospholipid
32%

cholesterol
31%

APICAL PLASMA MEMBRANE

glycosphingolipid
20%

phospholipid
52%

cholesterol
28%
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Figure 30. Colocalization analysis of fluorescent lipids in a supported lipid bilayer deposited on 

melted, silicon dioxide coated nanoparticle patterned surface. X-axis on all graphs shows the 

distance from the center of the nanoparticle. Y-axis data shows the radially averaged intensity for 

pixels falling within that distance from the center of the nanoparticle. A) Lipid films made with 

93-98% POPC, 2% MB-DHPE, 0 or 5% cholesterol, and 0 or 1% PEG-DOPE. B) Lipid films 

made with 93-98% POPC, 2% FL-DHPE, 0 or 5% cholesterol, and 0 or 1% PEG-DOPE. C) 

Comparison of the two fluorescently dye labeled lipids with membranes that contain PEG and 

those that do not. Each data set is 3 or more experimental days, N=3-5 for SEM. Total number of 
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particles for each data set are: 1307 for MB, 721 for MB.Chol, 714 for MB.PEG, 1082 for 

MB.Chol.PEG, 1921 for FL, 889 for FL.Chol, 2251 for FL.PEG, and 4380 for FL.Chol.PEG. 

Preliminary results from FRAP data analysis shows that fluid membranes are 

possible with the silicon dioxide coated nanoparticles. Diffusion constants for each lipid 

composition were calculated from the FRAP recovery curves (Figure 31 and Figure 32). 

 

Figure 31. FRAP recovery curves and diffusion constants for lipid membranes containing MB-

DHPE deposited on top of 100 nm melted, silicon dioxide coated nanoparticles. Diffusion 

(represented as D) units are μm2/s. Each recovery curve is from 3 experimental days and the 

following number of images: A) N = 10, B) N = 11, C) N = 7, D) N = 8. 
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Figure 32. FRAP recovery curves and diffusion constants for lipid membranes containing FL-

DHPE deposited on top of 100 nm melted, silicon dioxide coated nanoparticles. Diffusion (D) 

units are μm2/s. Each recovery curve is from 3 experimental days and the following number of 

images: A) N = 10, B) N = 10, C) N = 6, D) N = 10. 

4.4 Discussion 

This chapter shows three key advances for our membrane curvature biosensor 

assay. The first and second key advancements were to create a fixed and reusable 

nanoparticle substrate through annealing and sputter coating the nanoparticles. The third 

advancement was the addition of chambers to allow for smaller experimental working 

volumes.  

-10 0 10 20 30 40 50 60 70 80
0.0

0.2

0.4

0.6

0.8

1.0

1.2

Time(sec)

In
te

n
s
it

y

-10 0 10 20 30 40 50 60 70 80
0.0

0.2

0.4

0.6

0.8

1.0

1.2

Time(sec)

In
te

n
s
it

y

-10 0 10 20 30 40 50 60 70 80
0.0

0.2

0.4

0.6

0.8

1.0

1.2

Time(sec)

In
te

n
s
it

y

-10 0 10 20 30 40 50 60 70 80
0.0

0.2

0.4

0.6

0.8

1.0

1.2

Time(sec)

In
te

n
s
it

y

POPC, FL-DHPE POPC, FL-DHPE,

Chol

POPC, FL-DHPE,

DOPE-PEG

POPC, FL-DHPE,

Chol, DOPE-PEG

D = 0.103
D = 0.1209

D = 0.1847 D = 0.1027

A B

DC



 

 87 

A fixed substrate was done by sputter coating fluorescent nanoparticles patterned 

onto a glass coverslip. This process merged two current protocols to melt and coat 

fluorescent nanoparticles as seen in Figure 22 (8, 129). The permanence of the patterned 

substrate not only allows for washing and reusing them, but also applications of lipid 

bilayer and cellular membrane experiments. Due to the slightly larger well area and the 

more permanent nature of the 3D printed chambers, they are preferable to the smaller 

silicone rubber chambers (Figure 21). Furthermore, the pink colored silicone rubber 

caused scattering in the red channel with epifluorescence imaging, making it difficult to 

focus in the eyepiece. Black colored silicone rubber was then used and did not have 

scattering. The versatility of being able to 3D print chambered wall system in the size and 

shape needed for the experiment and having the ability to use plain coverglass or 

nanopatterned coverglass make this a desirable system. 

The AFM data from the University of Denver instrument contained a large 

amount of noise, however the images do indicate the relative distances between 

nanoparticles and although clumps do exist, that the majority of nanoparticles are 

separated (Figure 25). Furthermore, the larger size for the titanium sputter coated 

nanoparticles indicates that the AFM probe in tapping mode interacts widely with the 

metal. This was added for the purpose of increasing the AFM interaction, since earlier 

experiments with AFM on melted nanoparticles had failed to produce any images 

showing the nanoparticles (not shown here). The opportunity to use the AFM at Colorado 

State University allowed for a more accurate measurement with a suitable height of 80 

nm for a melted nanoparticle (Figure 26). 
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One use for this assay is to determine the curvature sensing ability of different 

lipid compositions and probes. FL-DHPE has been shown by others to prefer curvature 

and was used as our positive control (118). MB-DHPE is not expected to prefer regions 

of curvature over flat regions. The more a lipid membrane curves around a nanoparticle 

patterned region, the higher the intensity. Unless a lipid completely avoids curvature, it is 

expected to have a slight increase in intensity around the nanoparticle due to an increased 

surface area (established in Chapter Three). As seen in Figure 30, MB-DHPE has a 

smaller normalized intensity at the center of nanoparticles than FL-DHPE. This matches 

the expected results of others for FL-DHPE to sense curvature.  

The proposed experimental design was to test whether or not the addition of 

cholesterol or a lipid with a PEG head group would affect that curvature sensing. As seen 

in Figure 30A, the addition of PEG to a membrane decreases the intensity near the 

nanoparticle. This is most likely due to the size pushing it away from the surface and 

having less surface area to interact with the nanoparticle. Figure 30A also shows that the 

addition of cholesterol to membranes with or without PEG has the same effect – to 

increase the ability to sense curvature. It can be envisioned that the small size of the 

cholesterol would help lipid packing around nanoparticles. When comparing the same 

addition of cholesterol or PEG to membranes with FL-DHPE (Figure 30B), it appears 

that cholesterol does not affect the curvature sensing of a lipid that already has that 

ability, however, PEG still decreases the curvature sensing. The decrease in the ability of 

PEG to sense curvature can be applied as a mimic of the extracellular matrix and 

therefore cells would be expected to have a certain size of sputter coated nanoparticle 
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pattern that would no longer induce curvature in the membrane, but instead would grow 

the same as a flat membrane. This idea is supported by other research where micro-scale 

and nano-scale patterns affects cell growth differently (134, 135). 

4.5 Summary 

In this section, we have shown how the addition of a 30 nm silicon dioxide sputter 

coating to a nanoparticle patterned surface allows for cell growth without invagination of 

the nanoparticles. This sputter coating still had curved regions, as seen by the sensing of 

curvature with the colocalization analysis radial average results. The bilayers were also 

able to be bleached and recover, indicating that a fluid bilayer can form on top of the 

silicon dioxide coated nanoparticles. Overall, the addition of PEG to a membrane 

decreased its ability to sense the curvature. The fabrication of chambered systems to 

attach to the nanopatterned surface added the convenience of multiple experimental 

conditions to be tested at one time with lower volumes. Lastly, the ease of producing and 

reusing a 3D print chambered system and its cost-effectiveness will allow it to be applied 

to a vast array of experimental methods. 
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CHAPTER FIVE: CONCLUSION AND FUTURE WORK 

CRP biochemical research in this work showed significant C1q binding for mCRP 

made with 0.01% SDS and heated for 1 hour at 80 °C and for mCRP made with 1.5 M 

GndHCl. 7 M urea treated CRP showed some C1q binding, however, it was not 

significant compared with BSA binding. Structural analysis with Chimera software 

complimented the use of circular dichroism as well as intrinsic tryptophan and ANS 

fluorescence to analyze the various denaturants used. The transition from pCRP to mCRP 

was clearly seen on non-denaturing PAGE and with intrinsic fluorescence. Furthermore, 

the denaturation curve for GndHCl was used to calculate the Gibbs free energy of 

unfolding for CRP. 

The outer leaflet of apoptotic cell membranes was mimicked using a 

nanopatterned substrate to create curved, supported lipid bilayers and then used to 

characterize how CRP conformation affects the interactions between CRP and target 

membranes. In this assay, the chemical composition and shape are separately tunable 

parameters. The lipids consisted primarily of palmitoyl-oleoylphosphatidylcholine, with 

and without lysophosphatidylcholine, and the curvature had a radius of 27−55 nm. Using 

this model system combined with quantitative fluorescence microscopy methods, CRP 

binding to lipid membranes was measured as a function of different conformations of 

CRP. The modified form of CRP bound curved membranes, but the pentameric form did 

not for the range of curvatures measured. Unlike most other curvature-sensing proteins, 
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modified CRP accumulated more at a moderate curvature, rather than highly curved or 

flat regions, suggesting that the membrane bound form does not solely depend on a defect 

binding mechanism. The presence of lysophosphatidylcholine, a component of apoptotic 

membranes, increased CRP binding to all types of membranes. Overall, our results show 

that CRP interactions vary with protein form, lipid composition, and membrane shape. 

The mechanism by which CRP recognizes damaged membranes depends on the 

combination of all three. 

The final section of this work illustrates the advantages of a sputter coated 

nanopatterned substrate for both repeated use and for the versatility in applications from 

supported lipid bilayers to cells. Experimental options were added and imaging was 

facilitated by the addition of chambers (either cut silicone rubber or 3D printed PETG 

plastic). These chambered nanopatterned systems are reusable and reduce the 

experimental volume. Error bars from supported lipid bilayer experiments show 

consistency between days for reusing these systems. Results from colocalization analysis 

to check for curvature sensing indicates that the addition of cholesterol to membranes 

increases its ability to sense curvature and the addition of a lipid with a PEG attached to 

the head group decreases the ability for a lipid mixture to sense curvature. 

Future research to further understand and characterize this system includes the 

analysis of both cellular and supported lipid bilayer membranes with different sizes of 

nanoparticles and creating an eight well 3D printable chamber for attachment to a 24 x 50 

mm 1.5 coverglass plate. Initial testing of this coverglass size worked well with confocal 

imaging. Finally, along with publication, the files for the 3D printable chambers will be 
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made available on the NIH 3D print exchange website. Further analysis of FRAP of 

membranes with the new system is needed to confirm differences in fluidity.
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APPENDIX A: SUPPORTED LIPID BILAYER ON NANOPARTICLE 

PATTERNED SUBSTRATE 

This protocol is a detailed version (with troubleshooting tips) of the one outlined 

by Black, et al (8). 

Detailed instructions 

Preparation and Supplies Needed 

1. Use an 8 well chambered coverglass that has been pre-cleaned in advance by doing 

the following (#1.5 coverglass is preferred if doing sensitive assays due to better 

microscope images; #1 coverglass is less expensive – be consistent within an 

experiment): 

a. Cover with 0.1% SDS in a beaker - soak for 1 hour (usually 4-6 coverglass 

plates) 

b. Pour off SDS and cover with 1% Bleach solution in a beaker - soak overnight 

c. Pour off bleach and change solution to Millipore water (make sure it is 

covering the plates). Rinse 2-3 times with water. This is what they will be 

stored in until an experiment is performed. 

2. Use lipids (PC, PS, etc.) that have been prepared at DU by the following method: 

a. Lipids and dye labeled DHPE are combined with percent by mole. Total aim 

should be 250 nanomoles. Using the molarity (M) of PC, PS, or dye labeled 

(MB or TR) DHPE calculate the μL of each to add to the vials. 

b. Normally 6-8 vials are made at a time. Cover with foil and label each vial on 

the sides and top. 
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c. Glass syringes that are used with chloroform are not to be used with anything 

else (the syringes are labeled “Heather Syringe” or for S.P.T. only – SPT are 

NOT to be used with red lipids). 

d. Under the hood, measure out appropriate amounts for each dye/lipid, going 

from smallest to largest volume. Rinse syringe 5+ times with chloroform 

between/after use. Using the largest volume, swirl vial to mix lipids. 

e. Place open vials in vacuum, seal, and make sure hose path is correct, turn on 

and wait for bubble noise to stop, reposition stop-cock to create vacuum. 

Leave overnight. Clean up lipid stock by quickly blowing solution with argon 

or nitrogen to remove any oxygen from stock solution. Screw on lid and wrap 

with electrical tape. 

f. Turn off/remove vials from vacuum. Cover lipids with nitrogen. Screw on lid 

and store in freezer. 

3. Nanoparticles (if applicable) are found in the refrigerator – we usually use red 

fluorescent polystyrene fluorospheres (Invitrogen) 

4. Protein (C1q or CRP) and applicable antibodies if not using labeled protein 

5. Buffers/Solutions: 

a. 30 mM PIPES, 2 mM CaCl2, 140 mM NaCl, pH 6.4 

b. Hellmanex (2% by volume) 
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Experiment Day Procedure 

Note: Plan out 8-well grid before doing experiment (or while soaking with Hellmanex) 

All experiments should be done with a directional indicator on the wells. The #1 

plates have the word “LAB” on one side that you can place in the upper left. The #1.5 

plates have a notch that can be placed on the left. 

 
1 3 5 7 

2 4 6 8 

 

 

1. Using a Kim wipe or paper towel, dry off the 8 well chambered coverglass 

2. Add 100 μL of Hellmanex to each well, cover with lid and let sit 1 hour (at R.T.) 

3. If doing nanoparticles: 

a. Dilute with PIPES buffer (see concentrations below) 

i) Optional bath sonication for 15 minutes after 1st dilution to break 

up clumps as needed 

ii) 40 nm size dilute 1 μL with 999 μL (10^3), and sonicate for 15 

min, then dilute 1 μL of 10^3 solution with 999 μL of PIPES 

again (10^6 dilution total) 

iii) 100 nm size dilute 1 μL with 999 μL (10^3), and sonicate for 15 

min, then dilute 100 μL of 10^3 solution with 900 μL of PIPES 

again (10^4 dilution total). 

iv) 500 nm size dilute 1 μL with 999 μL (10^3), 

b. Empty wells using 100 μL pipette 

 L
A

B
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c. Rinse 3 times with 100 μL of PIPES buffer 

d. Add 100 μL of nanoparticle solutions, cover with foil and incubate at r.t. for 

30 minutes 

4. Lipids 

a. Prepare each lipid solution by adding 2 mL (or 2000 μL) of PIPES buffer to 

each lipid mixture vial that was prepared above (vacuum, nitrogen, etc.) 

b. Sonicate for 5 minutes with the probe sonicator on “2” setting (sand probe 

lightly with sandpaper if it has not been done in a while, and clean with 

ethanol before each use) 

c. Empty wells using 100 μL pipette (removing solution from wells, but leaving 

nanoparticles) 

d. Add 100 μL of appropriate lipids to each well. 

e. Cover with foil and incubate at 37 °C for 1 hour 

5. Proteins (note if not using proteins, follow step c to remove liposomes before 

imaging) 

a. Thaw in ice bucket 

b. Calculate amount of protein to add to each well to get desired concentration: 

either labeled (different concentration) or purchased protein. 

c. Rinse 3 times with 100 μL of PIPES buffer (adding lipids first, then remove; 

the wells need to stay wet). This should remove any liposomes floating in the 

mixture. 
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d. Add predetermined amount of protein and incubate for 1 hour at r.t. (Aml 

does CRP for 2 hours at 37 °C; some proteins, can be incubated for 10-15 

minutes) 

e. If using antibodies: pre-incubate primary and secondary together in 1:1000 

ratios for 30 minutes (covered with foil at r.t.) 

f. Add 100 μL of pre-incubated primary and secondary antibody to each well. 

Cover with Foil and incubate for 30 minutes. 

6. Image on Confocal or TIRF microscopes. Recording settings as needed. 

7. Putting data into folders for each well is useful. Name files with contents of well for 

future reference. The illustrations below show how different students number the 

wells. Whatever you do, be consistent! 

Carrie: 

1 3 5 7 

2 4 6 8 

Aml: 

8 7 6 5 

4 3 2 1 

Alan:  

1 2 3 4 

5 6 7 8 
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Troubleshooting and notes by steps 

1. Cleaning plates: 

a. Plates should be used within 2 weeks of cleaning or a small amount of 

sodium azide to the water should be added to prevent contamination with 

bacteria. 

2. Hellmanex: 

a. Do not keep Hellmanex on for more than 1 hour, it will start to dissolve 

the glue and cause the well to leak/break. 

b. If a well looks empty after the 1 hour, it most likely had a leak to begin 

with. Fill it with 100 µL of buffer and see if it empties out. If it does not 

stay full, you cannot use that well for the experiment. 

3. Nanoparticles: 

a. The first dilution of NPs (103) can be reused if stored in the refrigerator 

and shaken gently to resuspend prior to the second dilution. 

b. Do not keep foil on the tube when bath sonicating, the foil will break up 

with the sonication. Bath sonication is optional. Too much bath sonication 

appears to break up NPs and cause problems. 

c. NPs can be incubated for a longer period of time if needed, it will just 

increase the number of NPs that settle on the surface. 

d. Adding NPs and lipids at the same time causes NP islands to be formed 

above and below lipids. 
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e. An older batch of 100 nm red NPs was the reconstituted, so if using, the 

second dilution works best at 30 μL of the 103 solution with 970 μL of 

PIPES. 

4. Lipids: 

a. Lipid incubation time can be up to 2-3 hours at 37 °C. 

b. Incubating lipids at room temperature results in non-fluid bilayers. 

c. Failure to wash three times after lipid incubation keeps liposomes on the 

surface. 

d. Care should be taken when washing to only place the tip in one corner of 

the well and to keep the tip from touching the bottom of the coverslip (tip 

should be in the buffer). 

5. Protein: 

a. If the protein is in the freezer, be sure to allow at least 30 minutes prior to 

the end of lipid incubation to thaw it on ice. 

b. If using antibodies, pre-incubate when 30 minutes are left for protein 

incubation. 

6. Imaging: 

a. If there is extra time before scheduled imaging, finished coverslips can be 

stored covered with foil at 37 °C or room temperature for 1-2 hours. 

b. Multiple channels should be imaged on the confocal sequentially by line 

(not simultaneously).  
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Quick Reference 

Experimental Date: __________________________ 

Plan: ___________________________________________________________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

Well #:___ 

________________ 

________________ 

________________ 

 

  

Hellmanex •1 hour, R.T.

Nano-
particles

•Dilute 1:1000 in buffer

•2nd Dilution (by size)

• Incubate 30 min, R.T.

Lipids
•2 mL buffer

•Probe Sonicate

• Incubate 1 hour, 37C

Protein
• Incubate 1 hour, R.T. 
(some proteins 2 
hours, 37C)

Antibodies

•Pre-incubate 30 
min, R.T.

• Incubate 30 min, 
R.T. in well

L
A

B
 

Remove and 

Wash 3X’s 

Remove 

buffer, DO 

NOT WASH 

Add 100 uL, 

remove 100 uL, 

repeat 3X’s 

Experimental Notes: 

___________________________

_________________________

_________________________

_________________________

_________________________

_________________________

_________________________

_________________________

_________________________ 



 

 113 

APPENDIX B: FRAP DATA ANALYSIS 

This is a detailed protocol for the correction and analysis for Fluorescence 

Recovery after Photobleaching (FRAP) data from the confocal microscope and was 

modified from a protocol written by Alec Feuerbach. 

Correcting for overall photobleaching 

1. Open FRAP image (.oib from Confocal; if saved on newer Confocal as .oir file, 

convert to .oib in Fluoview software) in ImageJ (http://imagej.nih.gov/ij/) 

2. Click on the ROI to display it or if it is not displayed, create an ROI where the bilayer 

was bleached. 

 

3. Collect intensity data for the FRAP ROI over the whole series by clicking the 

following in the “ROI Manager” window: 

a. More 

b. Multi-Measure 

c. Checked boxes for “Measure all slices” and “One row per slice” 

d. OK 
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e. Results appear in a new window 

 

4. Transfer data to Excel: 

a. Open Excel 

b. In the Results window in ImageJ do: 

i. Edit 

ii. Copy 

c. Go to cell D3 and Paste 

d. Fill out the D2-H2 cells with the appropriate heading and write 

“FRAP Data” in D1. 
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5. In ImageJ, move the ROI to another region away from the bleached area in order to 

measure the background intensity/bleaching 

 

6. Click “Add” in the ROI Manager to add the region of interest that you want to 

measure and select the new ROI before measuring the ROI. 

7. In the “Results” window do: 

a. Edit -> Select All 

b. Edit -> Clear 

8. Repeat steps 3 and 4, with the exception of pasting the data in J3 and putting the title 

“Background ROI” in J1. 
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9. The excel spreadsheet should now look like this along the top: 

 

10. Get a photobleaching correction value for the background (random) ROI by dividing 

the intensity of the first slice by each slice intensity (in cell P3, the equation 

=$L$3/L3 is entered and dragged down the column to fill in the equation). Numbers 

should start with 1 and get larger. 

 

11. In A1 type “Corrected FRAP Data” and in A2 type “Time (sec)” 

a. In ImageJ, find the frame interval by going to Image -> Properties 
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b. In Excel, in cell A3 use the formula =(D3-# of frames to 

activation)*(frame interval). Note the # of frames to activation is 

the preactivation +1. In the case of a preactivation of 3, the number 

used is 4. The lowest intensity will line up with Time= 0. 

c. Drag to fill formula 

 

12. In B2, type “Corrected Avg Intensity” (or Mean) 

13. Multiply the average (mean) intensity of each slice from the FRAP ROI (Column F) 

by the Correction value for that slice (Column P). To do this B3 will have =F3*P3. 

Drag/fill this formula for all slices. This should give a corrected value for bleaching 

that occurs on the entire image while doing long periods of time for FRAP.  

 

 

14. Save and Copy/Paste this data into a GraphPad Prism XY plot. 
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Plotting Recovery Curves and Calculating Diffusion Coefficients 

 The directions in this section are for using GraphPad Prism to fit the following 

equations for fitting FRAP data and calculating diffusion coefficients (8). 

𝐹(𝑡) = 𝐹0 + (𝐹∞ − 𝐹0) ∗ (1 − 𝑒−𝑘𝑡) 

𝐷 = (
𝑤2

4𝜏ℎ𝑎𝑙𝑓
) 𝛾𝐷 

𝜏ℎ𝑎𝑙𝑓 =
ln 2

𝑘
 

Where F0 is the initial fluorescence and F∞ is the fluorescence at equilibrium. K is the rate 

constant and t is time in seconds. D is the diffusion coefficient in μm2/s. γD is defined as 

0.88 for a circular beam and τhalf is the time at 50% recovery. For the experimental data 

processed here w is the radius of the bleaching region of interest (ROI) in μm. 

The first step is to normalize the corrected data in the XY data table in GraphPad 

Prism. To do this, click on the analyze button from the menu along the top and select 

normalize. Define 0% as the smallest value and 100% as the first value. Choose to 

present data as fractions. 
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Next calculate the Mean and SEM of the normalized data by selecting Analyze and then 

Row Stats. 

In the Analysis box click: fit with non-linear regression curve and select the “Diffusion 

Coefficient from FRAP recovery curve” equation or add the following as a custom 

equation: 

 Equation: Y=Y0 + (Plateau-Y0)*(1-exp(-K*x)) 

 Default Constraints: K must be greater than 0 
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The transforms to report section is where the diffusion constant calculation will need to 

be adjusted for different bleaching ROI sizes. The table below gives some examples of 

confocal zooms with their corresponding pixel resolutions and different radii. 

Zoom with 100X objective nm/pixel Radius for ROI 

1X 240 15.5 μm for 125x125 pixel tornado 

2X 124 7.75 μm for 125x125 pixel tornado 

2.5X 100 6.25 μm for 125x125 pixel tornado 

2.486 μm for 50x50 pixel tornado 

3X 82 5.17 μm for 125x125 pixel tornado 
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When fitting the data, if X values greater than 0 are included in the fit, there will be an 

error. This can be fixed by adjusting the range, as shown below. 

 

Diffusion constants can now be seen in the results and a corresponding graph with the 

linear fit will be in the graphs section. 
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APPENDIX C: NON-DENATURING PAGE AND SILVER STAIN PROTOCOL 

The non-denaturing polyacrylamide gel electrophoresis protocol has been 

modified from standard Laemmli conditions (68). The silver stain protocol was taken 

from the laboratory notebook of Kathryn Palma, a former student who worked in Dr. 

Knowles’ lab at the University of Denver. Nature protocols has two journal articles for 

silver stain protocol with detailed explanations for the steps (136, 137). 

Non-Denaturing PAGE 

     

1/20th SDS   

Running Gel 10.0% 

(mL) (µL)   

Combine the following: 

4.1667 4166.7 30% Acrylamide 

3.1250 3125.0 1.5 M Tris-HCl pH 8.8 

0.0063 6.25 10% SDS 

5.0646 5064.6 (to add up to 12.5mL) Water 

0.1250 125.0 10% APS (Ammonium Persulfate) 

Swirl to Mix   

0.0125 12.5 100% TEMED 

Swirl to Mix   

Pour & let set 10-20 min (put thin layer of ethanol on top) 

     

Stacking Gel 3.2% 

(mL) (µL)   

0.2667 266.7 30% Acrylamide 

0.3125 312.5 1 M Tris-HCl pH 6.8 

0.0013 1.25 10% SDS 

1.8646 1864.6 (to add up to 2.5mL) Water 

0.0500 50.0 10% APS (Ammonium Persulfate) 

     

0.0050 5.00 100% TEMED 

Swirl to Mix   
Pour & let set 20 
min   

Store in Ziploc bags in fridge, wrapped in paper towels, 

soaked in 1.5 M Tris-HCl pH 8.8 buffer 
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Silver Stain of Native PAGE Procedure 

Make the following solutions (filling to total volume with diH2O): 

• Fixing Solution (50 mL total) 

o 25 mL of Methanol (final = 50%) 

o 2.5 mL of Acetic Acid (final = 5%) 

o 25 µL of 37% Formaldehyde (final = 0.0185%) 

• 50% Methanol (2 × 50 mL total, 25 mL of methanol in each) 

• 10% Sodium Thiosulfate (Na2S2O3)-need 150 µL minimum (good for 1 week) 

o equivalent of 10 g/ 100 mL or 10 µg/ 100 µL 

o _______ mg x 10 = ________ µL 

• Sensitizing Solution (25 mL total) 

o 50 µL of 10% Sodium thiosulfate (final = 0.02%)  

• Silver Stain (25mL total) 

o 50 mg Silver Nitrate – AgNO3 (final = 0.2%) 

• Developer (25mL total) 

o 50 µL of 32% Formaldehyde (final = 0.074%) 

o 1.5 g Sodium Carbonate (Na2CO3) (final = 6%) 

o 100µL of 10% Sodium Thiosulfate (Final = 0.04% 

• Stopping Solution (50 mL total) 

o 25 mL Methanol (final = 50%) 

o 2.5 mL Acetic Add (final = 5%) 
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Use 25mL for each step below (except step 8): 

        1. Fix (rock in fixing solution) 2×15 min 

        2. Wash 3×8 min with 50% Methanol 

        3. Sensitize 60 sec 

        4. Wash 2×20 sec diH2O 

        5. Silver stain for 30 min 

        ► Place waste in appropriate container 

        6. Wash 2×30 sec diH2O 

        7. Develop until bands show 

        8. Add stopping solution (50mL) 

                Swirl until no more bubbles 

        9. Wash 10 min with 50% Methanol 

        10. Final rinse diH2O 

        11. Image/scan and save file  
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APPENDIX D: COLOCALIZATION MATLAB ANALYSIS 

The steps for MATLAB analysis of microscopy images for colocalization are 

outlined below. This chapter also includes directions for removing non-cellular 

nanoparticles when looking for colocalization between nanoparticles and cell membranes. 

The MATLAB code used for the data analysis is included at the end. The majority of this 

code was written by Dr. Michelle Knowles, Mitchell Alton, or Dr. Philip Cheney. 

 

Data Analysis 

1. Open Olympus Fluoview FV31S-SW 

a. File > Export Multiple Files 

b. Select folder create new “Exported Images” subfolder for saving files 

c. Select no overlay 

d. Output format: Raw Data Extracted, 16-bit Gray Scale, no compression 

e. This will save each image in its own folder and each channel as separate 

image file 

2. Open MATLAB 

a. Find the folder with the image files using the window on the left side of 

the screen 

b. Type run_ministk in the command window and press enter 

i. Choose the red and green channel images 

ii. Choose the name and where to save the images 
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3. If needed, cut out saturated pixels: 

a. Open the folder that has the *.stk images in MATLAB (Alternatively, 

open a parent folder and search for .stk and then select each one with 

CTRL help down and then copy/paste into a new folder named “blue 

stacks” or “green stacks”. This is useful for large numbers of stacks to be 

easily processed.) 

b. Type cutout_saturated in the command window and press enter 

c. Choose the file that you want to remove saturated slices from 

d. Save the unsaturated image 

4. Use ImageJ to concatenate all of the images from a single well for the day 

a. Open all of the stacks you want to concatenate 

b. On the ImageJ toolbox, click the Stk button and then ‘Delete Slice’ to 

delete the first black slice on each stack 

c. Then click the Stk button again and click concatenate and select all the 

open files on the window that pops up 

d. Save as > tiff 

e. Save average of the concatenated stack (to use below) 

f. Repeat Concatenation for every day of the experiment with those settings 

5. To get the radial average, type the following into MATLAB (with the folder open 

in MATLAB), changing the red text for the file name(s) as needed (you can have 

more than one file in the same folder and copy/past multiple text at once). 
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g_rand=TIFFStack('WellD.100nmsputter.MB.Chol.PEG.Concat.tif'); 

a=make_avgradial(g_rand); 

xlswrite('WellD.100nmsputter.MB.Chol.PEG.Concat.AVGradial+stdev+sterr.xls', a); 

 

If you forget to change the name in the xlswrite part of the code, then you can rename it 

in the folder after it is saved. 
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Removing Non-Cell Nanoparticles from Images 

1. Open oib file in ImageJ 

2. File > Save As> Image Sequence (new folder for image sequence) 

3. Open newly saved .tiff of CellMask (green) channel 

4. File >Save As> Tiff – type 8 bit after the name 

5. Image > Type> 8 bit 

6. Image > Adjust > Threshold (this should highlight the cell/fluorescent regions 

only – the cutoff values can be adjusted in the window that pops up). 

7. Edit > Selection > Create Selection (to get threshold highlighted region outlined) 

8. Analyze > Tools > ROI Manager to open the ROI Manager 

9. In the ROI Manager, after clicking on the cell mask image click “Add” 

10. Open the Nanoparticle .tiff saved in step 2 

11. Click on the ROI listed in the ROI manager so it is displayed on the image 

12. If some regions that were highlighted are from the background/not clean (most 

likely), select the following in the ROI manager: More > Split 

13. There should now be a large number of ROIs listed (usually hundreds). To find 

the wanted ROIs, make sure Show all and Label are both checked. This will allow 

you to click on the ROI you want and find it in the list. The ROIs are listed in 

order of left to right, top to bottom from the lowest part of the ROI. Try to select 

the top cell region first and then click on one ROI up above it and hold down 

shift. Using the mouse, scroll to the top and click on the 2nd ROI (the first should 

be the entire original ROI). Then hit “Delete”. Continue to do this or to school 
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with the arrows on the keyboard and delete all the unwanted ROIs. This should 

leave you with 1-4 cell area ROIs. 

14. Select each cell ROI (not the top one that was the original with everything) and go 

to: More > Or (combine) 

15. The cell regions that you want to keep should now be selected in the NP channel 

16. In the main menu: Edit > Clear Outside 

17. File > Save as > Tiff > add “Noncell NPs removed” to the file name. 

18. Delete all the ROIs left in the ROI manager after you close the images and then 

repeat with the other images. 
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MATLAB Code 

run_ministk 

function [] = run_ministk ( ) 

  
%ask for red and green channels 
[redfile,redpth] = uigetfile('*.tif','Select the Red Channel'); 
[grnfile,grnpth] = uigetfile('*.tif','Select the Green or Blue 

Channel'); 

  
%ask where to save the resulting file 
[savefile,savepth] = uiputfile('*.mat','Where to save the Results'); 

  

%read in an image 
a=imread([redpth,redfile]); 
c=imread([grnpth,grnfile]); 

  
%view the image, imagesc autoscales. 
colormap('gray'),imagesc(a); 

  
% filter the image, 9 is a size, filter things larger than 9 pixels, 

and filter 1 or smaller 
b=bpass(a, 1, 9); 
colormap('gray'),imagesc(b); 
colormap('gray'),image(b);   
%seems to make a saturated mask like image when using beads 

  
%use the filtered image to find regions. 100 is the threshold and 9 is 

a size of feature  
%you are looking for. Should be the same as above. RECORD THESE NUMBERS 

IN  
%YOUR NOTEBOOK! 
pk=pkfnd(b, 100, 9); 

  
%find centroids -  NOT NEEDED for colocalization routine 
cnt=cntrd(b, pk, 15); 

  
%overlay regions onto non-filtered image. Adjust the threshold to find 

fewer or more  
%spots.  
colormap('gray'),imagesc(a); 
hold on 
plot(pk(:,1), pk(:,2), 'ro'); 
zoom 

  
%once you like the threshold and want to cut out ministacks 
%do this with both color channels so that you can check it.  
cutout_red = ministk(a, pk, 24, 9); 
cutout_grn = ministk(c, pk, 24, 9); 
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%a is the image you will be cropping, pk are the regions you would like 

to crop, 24 (+1)  
%is the size of images you will cut out and if spots are too close 

(within 9 pixels of one  
%another) you will not count either of them.  

  
%save the file 
stkwrite(cutout_red,strcat(savefile,'-red.stk'),savepth); 
stkwrite(cutout_grn,strcat(savefile,'-MB.stk'),savepth); 

  
cutout_red_avg = uint16(mean(cutout_red,3)); 
cutout_grn_avg = uint16(mean(cutout_grn,3)); 

  
stkwrite(cutout_red_avg,strcat(savefile,'-red-avg.stk'),savepth); 
stkwrite(cutout_grn_avg,strcat(savefile,'-MB-avg.stk'),savepth); 

  
%see what regions were kept and save them. You do NOT need to do this 

with both  
%image files, since the spot locations will be identical. 
finalspt = keptspot(a, pk, 24, 9); 
save(fullfile(savepth,savefile)); 

  
% you can view what spots were kept and what were ?too close? to others 

or the edges. 

  
colormap('gray'),imagesc(a); 
hold on 
plot(finalspt(:,1), finalspt(:,2), 'ro'); 
zoom 

  
%Added by Carrie Moon to save image of which NPs were selected 
hgexport(gcf, fullfile([savefile '-selected-NPspots.png']), 

hgexport('factorystyle'), 'Format', 'png'); 

  

  
%% Make a radial plot of pixel intensity 
% This is Mitch Alton's implementation 

  
hold off; 

  
[m, n]=size(cutout_grn_avg); 

  
%finds size of the image 
x=[1:n]; 
l=repmat(x,n,1); 

  
%creates matrix of repeating columns of 1 through how ever many columns 
%there are in the image 
y=[1:m]; 
y'; 
p=repmat(y,m,1); 
w=p'; 
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%creates matrix of repeating rows 
x=l-(((n-1)*0.5)+1); 
y=w-(((n-1)*0.5)+1); 

  
%makes matrixes -# to +#. Not sure how this will work with even numbers 
%though 
z=cutout_grn_avg(1:m,1:n); 

  
%creates a matrix of intensities from image 
[THETA,RHO,Z]=cart2pol(x,y,z); 

  
%converts three matrixes to a three dimensional polar coordinate matrix 
%G=reshape(z,1,625); 
%H=reshape(RHO,1,625); 

  
%turns matrix into a list of values 
[t,I,J] = unique(RHO); 
s = zeros(size(t)); 
frequencies = zeros(size(t)); 
for i = 1:max(J) 
    I = find(J==i); 
    s(i) = mean(Z(I)); 
    frequencies(i) = length(I); 
end 
plot(t,s) 

  
% Save the files 
radialPlot = cat(2,t,s); 
hgexport(gcf, fullfile(grnpth,[savefile '-MB-radial.png']), 

hgexport('factorystyle'), 'Format', 'png'); 
csvwrite(fullfile(grnpth,[savefile '-MB-radial.csv']), radialPlot); 

  

  

  
[m, n]=size(cutout_red_avg); 

  
%finds size of the image 
x=[1:n]; 
l=repmat(x,n,1); 

  
%creates matrix of repeating columns of 1 through however many columns 
%there are in the image 
y=[1:m]; 
y'; 
p=repmat(y,m,1); 
w=p'; 

  
%creates matrix of repeating rows 
x=l-(((n-1)*0.5)+1); 
y=w-(((n-1)*0.5)+1); 
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%makes matrixes -# to +#. Not sure how this will work with even numbers 
%though 
z=cutout_red_avg(1:m,1:n); 

  
%creates a matrix of intensities from image 
[THETA,RHO,Z]=cart2pol(x,y,z); 

  
%converts three matrixes to a three dimentional polar coordinate matrix 
%G=reshape(z,1,625); 
%H=reshape(RHO,1,625); 

  
%turns matrix into a list of values 
[t,I,J] = unique(RHO); 
s = zeros(size(t)); 
frequencies = zeros(size(t)); 
for i = 1:max(J) 
    I = find(J==i); 
    s(i) = mean(Z(I)); 
    frequencies(i) = length(I); 
end 
plot(t,s) 

  
% Save the files 
radialPlot = cat(2,t,s); 
hgexport(gcf, fullfile(grnpth,[savefile '-red-radial.png']), 

hgexport('factorystyle'), 'Format', 'png'); 
csvwrite(fullfile(grnpth,[savefile '-red-radial.csv']), radialPlot); 

  
%close 
end 
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ministk 

function out=ministk(im,rgn,sz,sepdist) 
% out=ministk(im,rgn,sz) 
%  
% PURPOSE:  to cut out small regions of an image based on spots found 

in 
% the image or a corresponding image of a different color. This is used 

to 
% measure colocalization based on the work of Knowles and Barg in two 

PNAS 
% 2011 papers. Spots are found using the work of tracking routines 
% available on Eric Weeks' website (Emory University) and made into 

Matlab 
% by Eric Dufrense. 
% INPUT: 
% im: image to cut from 
% rgn: spots (x,y) about which regions should be cut 
% sz: size of cut out (a square of sz by sz pixels) 
% sepdist: is the minimum separation distance between two spots. If two 
% spots are within this distance of one another, neither are counted. 
% 
% OUTPUT:  a sz x sz x N image array 
%            
% CREATED: Michelle Knowles May 2012 

  
%if sz/2 == floor(sz/2) 
%warning('sz must be even so that the spots can be centered on a pixel: 

1 pixel added'); 
%sz = sz+1 
%end 

  
%scott's code for a mask 
pix=(sz+1)/2; 
dim = length(im); 
nrgn = length(rgn(:,1)); 

  

  
%create a blank image array that you can fill 
msk=zeros([sz+1,sz+1]); 
%loop through all regions that locate spots in an image 
for i =1:nrgn; 
    x = rgn(i,1); 
    y = rgn(i,2); 
    %don't include regions within pix distance from the edge of the 

image. 
    if ((x>pix) & ((x+pix)<dim) & (y>pix) & ((y+pix)<dim)) 
        % don't include regions within "sepdist" pixels of another 

region 
        % calculate an array that contains the difference between the 
        % current particle's position and all others. 
        diffy=rgn(:,2)-rgn(i,2); 
        diffx=rgn(:,1)-rgn(i,1); 



 

 135 

        mag=((diffx.*diffx)+(diffy.*diffy).^0.5); 
        % find all the locations in the magnitude array that are non-

zero. 
        % This should remove the comparison between particle i and 

itself, 
        % which will always be zero.  
        w = find(mag); 
        mag = mag(w); 
        if (min(mag) > sepdist)   
          cutout = imcrop(im,[x-pix y-pix sz sz]); 
          msk = cat(3, msk, cutout); 
        end 
    end 
end 

  
out=msk; 
end 
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cutout_saturated 

function cutout_saturated(stk) 
% out=remove_sat(stk) 
%  
% PURPOSE:  to remove any images that have an oversaturated pixel. This 

is 
%used to eliminate any error when using this program if saturated 

pixels 
%were mistaken for spots in a previous program. 
% INPUT: 
% stk: stk file to find saturated pixels in 
% OUTPUT:  a sz x sz x N image array 
%            
% CREATED: Mitch Alton 2015 

  
%Phil's code for mask 

  
stk=stkread; 
%choose .stk file from browser 
ind=find(stk>4094); 
%this finds every pixel that has a brightness greater than 4094 
frame=fix(ind/625)+1; 
%divides the pixel number from ind by total number of pixels in one 

image 
%and makes it an integer. When added to 1, identifies the image number 

of 
%stack 
x=unique(frame); 
%eliminates repeating numbers 
b=1:length(stk); 
%creates list of numbers from 1 to however number of images is in the 
%stack 
b(x)=[]; 
%eliminates image numbers from list of numbers that have saturated 

pixel 
%mask=ones(size(stk)); 
%for index=1:size(stk); 
   % listMask(1,list(1,index))=0; 
%end 
%we got rid of this mask 
new=stk(:,:,b); 
stkwrite(new); 
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make_avgradial 

function [ avgradial_out ] = make_avgradial(imagestk) 
%loop through better_colo to get a radial plot for each image, then 

average 
%all radial plots. Output average and standard deviation. 

  
dims =  size(imagestk); 
radial = zeros(83, dims(:,3)); 

  
for i = 1:dims(:,3) 
    radial(:,i)=better_colo_V2(imagestk(:,:,i)); 
end  
avgradial_out = zeros(83,3); 
avgradial_out(:,1) = mean(radial,2); 
avgradial_out(:,2) = std(radial,0, 2); 
avgradial_out(:,3) = avgradial_out(:,2)/sqrt(dims(:,3)); 
end 
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better_colo_V2 

function  [ radial_out ] = better_colo_V2(a) 
%better_colo plots intensities of a location guided average image as a  
%function of distance from the center of the image.  
%Not needed at the moment but the program does this: The second half of 

the 
%program finds the area under the peak of the radial intensity plot. It 
%does this by subtracting the area of the rectangle under the peak (the  
%peak ends 3 pixels away from the center) using the mean of the data 

after  
%the third pixel as the height of the rectangle.  
%Written by Mitch Alton on 7/1/15 
%adapted for no user input and mass throughput of images by MKK 

9/27/2016 

  
%finds size of the image 
[m,n]=size(a); 

  
%creates matrix of repeating columns of 1 through however many columns 
%there are in the image 
x=[1:n]; 
l=repmat(x,n,1); 

  
%creates matrix of repeating rows 
y=[1:m]; 
y'; 
p=repmat(y,m,1); 
w=p'; 
%makes matrixes -# to +#. Not sure how this will work with even numbers 
%though 
x=l-(((n-1)*0.5)+1); 
y=w-(((n-1)*0.5)+1); 
%creates a matrix of intensities from image 
z=a(1:m,1:n); 

  
%converts three matrixes to a three dimensional polar coordinate matrix 
[THETA,RHO,Z]=cart2pol(x,y,z); 

  
%turns matrix into a list of values 
P=reshape(Z,1,[]); 
H=reshape(RHO,1,[]); 

  
%this averages the intensities (Z) for single distance (RHO) values 
[plt,I,J] = unique(H); 
s = zeros(size(plt)); 
frequencies = zeros(size(plt)); 
for i = 1:max(J) 
    I = find(J==i); 
    s(i) = mean(P(I)); 
    frequencies(i) = length(I); 
end 
radial_out = s.';  
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APPENDIX E: RESOLUTION OF TOTAL INTERNAL REFLECTION 

FLUORESCENCE MICROSCOPE 

Total internal reflection fluorescence microscopy (TIRFm) requires a change in 

refractive index between the glass coverslip and the sample. The TIRFm instrument used 

in the Knowles Lab has two TIRF objectives (60x and 100x). There is a 1.5x zoom that 

can be applied through the microscope and the option of either a dual view or a 2.5x 

optical zoom pathway between the microscope and the camera. The following is a table 

compiled from micrometer measurements taken with the dual view insert at the various 

settings. Dual view values in the table below were divided by 2.5 to get the approximate 

resolution with the dual view removed and the 2.5x zoom attached. 

Objective Zoom DualView? nm/pixel 

60 1 Yes 268.8 

60 1 2.5 107.5 

60 1.5 Yes 180.5 

60 1.5 2.5 72.2 

100 1 Yes 133.0 

100 1 2.5 53.2 

100 1.5 Yes 88.5 

100 1.5 2.5 35.4 

 

Steps for micrometer measurements above: 

1. ImageJ 

a. Open image 

b. Add a scale bar under Analyze > Tools and then save as .jpeg 

c. Open ROI Manager (Analyze > Tools > ROI Manager) 
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d. Draw a rectangle over the area with the micrometer (either lower ½ if dual 

view in or entire image if bypass or 2.5X) 

e. Click “Add” in ROI manager 

f. Select the newly added ROI 

g. More > Multi Plot 

h. Save as a .xls 

2. Excel 

a. Open (select yes) and select Save As and in dropdown select .xls again (states 

the current is tab delimited text), and yes to save over current file by that name 

b. Highlight columns A and B > Insert > Scatter Plot (with lines, not points) 

c. Highlight B > Conditional Formatting > Highlight cell rules > Less than > 

Pick value based on dips in graph (i.e. 400 or 550) 

d. Go through list and highlight in A the cells next to the ones highlighted in B. 

This will display an average in the lower right of the Excel window. Select the 

corresponding X value (pixel distance) and highlight it in orange (or do 2 cells 

if not a whole pixel, i.e. if the average is 5.5, then color 5 and 6). Repeat for 

all the dips and write the average pixel distance above the graph in individual 

wells. 

e. The space between the lines is 10 µm. Take each of the values above the 

graph for the line centers and subtract the consecutive ones from each other to 

get the pixel distance between the lines. Take the average of this (average 

pixel distance for 10 µm). 
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f. Use a formula to do =10000/(average pixel distance) 

 

Sample micrometer image taken with the 60X TIRF objective at 1X zoom with the dual 

view active. 

 

Note: The websites below contain extensive TIRF background and information: 

https://www.microscopyu.com/techniques/fluorescence/total-internal-reflection-

fluorescence-tirf-microscopy  

and  

http://www.olympusmicro.com/primer/techniques/fluorescence/tirf/tirfhome.html 
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APPENDIX F: DEDICATION 

To those who taught me many things 

From how to read to calculations for biophysical springs 

To how to deal with what life brings 

To those who have helped me on the way 

With support and prayers for every day 

To those who believed that I would 

Do more than I even thought I could 

 

To those who listened day and night 

To those who reviewed a protein binding site 

And who patiently looked over each rewrite 

To those who answered all my questions 

And offered many kind suggestions 

To those who mentored me with care 

To friends and family everywhere 

 

It means so much that you have seen me through 

And I dedicate this tome to you 
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